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Warranty Registration 
Please complete the enclosed Warranty Registration Card and send it to Lasergraphics.  Warranty 
registration enables us to keep you informed of new developments for WinRascol. 



4 

Acknowledgements 
The combined effort of many people is required to make a quality software product. This is an 
undoubtedly incomplete list of dealers, customers, coworkers and friends who have been helpful in one 
way or another in making WinRascol 5 into what it is today. 

Hanspeter Andermatt, Wolfgang Beaugrand, Xavier Bengoechea, Tim Bochnak, Murray Bowman, Dr. 
Ralf Brandes, Tony Brown, Falah Chebbo, Larry Cole, David Davies, Mike DeLucca, Dr. Stefan 
Demetrescu, Jo Elliot, Jon Elion, LtCol Dr. Doug Erickson, David Hard, Wenxin He, Ron Herman, Jack 
Hobbs, Andreas Hölling, Thomas Hofmeister, Genie Jacobsen, Dr. Jürgen Krüger, Bill Kruki, Jörg Kunz, 
Klaus-Norbert Laroche, Beat Lechmann, Wai-Hung Lee, Adrian Martin, Bob McCormack, Rod Miller, 
Martin Müller, Rick Narveson, Chris Olsen, Doris Rusch, Doug Schafer, Steffen Seeber and Bill 
Smithson. 

Thank you all. 

 

 

This software is based in part on the work of the Independent JPEG Group (IJG). 

This software is based in part on the ZLIB compression library written by Jean-loup Gailly and Mark 
Adler. 

This software is based in part on the libpng library written by members of the PNG Development Group. 

Thank you for providing incredibly useful code.



 Contents 5 

Contents 
 

 

Chapter 1: Introduction ........................................................................................13 
What You Need ...............................................................................................14 

Required Hardware ...............................................................................14 
Required Software.................................................................................14 

About this Guide ..............................................................................................15 
What’s new ......................................................................................................16 
WinRascol Features ........................................................................................17 

Various Output Types ...........................................................................17 
High Resolution .....................................................................................17 
True Color .............................................................................................18 
High Speed............................................................................................18 
Easy to Use and Highly Compatible......................................................19 
Allows Film Recorder Sharing on Networks..........................................19 

Chapter 2: Express Setup ....................................................................................21 
Installing the Hardware....................................................................................21 
Installing WinRascol ........................................................................................22 
Installing Windows BLL Generators ................................................................23 



6 Contents 

Chapter 3: Hardware Installation ........................................................................ 25 
Installing the RascolPort Hardware .................................................................26 

Installing a RascolPort...........................................................................27 
Using the RascolPort with a Standard Printer.......................................28 

Installing Rascol II and IV boards ....................................................................29 
Installing the Rascol II board .................................................................29 
Installing Rascol IV................................................................................30 

Installing a RISCRascol ...................................................................................31 
Installing the Film Recorder.............................................................................31 

Chapter 4: Software Installation.......................................................................... 35 
Running setup..................................................................................................36 
Running WinRascol for the first time ...............................................................37 
Adding a queue................................................................................................38 

Chapter 5: Printing your first image ................................................................... 41 
Printing the Test Slide......................................................................................42 
Printing from an Application.............................................................................46 

Chapter 6: Principle of Operation ....................................................................... 51 
Introduction ......................................................................................................51 

Printing from Windows on a PC with Film Recorder .............................52 
Adding Images Directly to a Queue.......................................................53 
Printing from Windows on a PC without Film Recorder ........................54 
Adding Images Directly to Dropboxes...................................................56 

Important Concepts .........................................................................................58 
Resolution..............................................................................................58 
Color Fidelity..........................................................................................59 
Bitmaps and Objects .............................................................................60 

Graphics ......................................................................................60 
Text .............................................................................................60 



 Contents 7 

Which Applications Create Bitmaps or Objects ..........................61 

Chapter 7: Reference............................................................................................63 
Printer Settings ................................................................................................63 

Resolution .............................................................................................63 
Orientation and Paper Size ...................................................................64 
Film Type...............................................................................................65 

LFC-based Film Types................................................................65 
Background Color..................................................................................65 
Scaling...................................................................................................65 
Antialiasing ............................................................................................65 
Minimum Exposure Time ......................................................................65 
Color Balance........................................................................................66 
Contrast Gamma...................................................................................66 
Pen Colors.............................................................................................66 
Plotter Emulation ...................................................................................66 
Line Thickness ......................................................................................67 
Rotation .................................................................................................67 
Interpolation...........................................................................................67 

Using the Windows 9x/ME driver ....................................................................68 
Printer settings in Windows 9x ..............................................................68 
Color balance and gamma correction ...................................................71 
Miscellaneous options...........................................................................72 
Changing the Default Printer Settings in Windows 9x/ME....................74 

Using the Windows NT/2000/XP driver ...........................................................75 
Printer settings in Windows NT, Windows 2000 and Windows XP.......75 

Storing Changed Settings ...........................................................77 
Changing the Default Printer Settings in Windows NT/2000/XP ..........78 

Using WinRascol .............................................................................................79 
Starting WinRascol................................................................................79 



8 Contents 

Exiting WinRascol .................................................................................79 
Adding Print Jobs to a Queue ...............................................................79 

Add Job .......................................................................................80 
Drag and Drop.............................................................................81 
Adding jobs using paste ..............................................................81 

Managing Print Jobs..............................................................................82 
Starting and Stopping a Queue...................................................82 
Checking Print Job Status...........................................................82 
Changing Print Job Status ..........................................................82 
Displaying/hiding Print Job Columns ..........................................83 
Selecting Print Jobs ....................................................................83 
Moving Print Jobs........................................................................84 
Deleting Print Jobs ......................................................................84 
Previewing Print Jobs..................................................................84 
Previewing  Print Jobs with Explorer...........................................84 

Changing Print Job Settings..................................................................85 
Film and Resolution ....................................................................86 
Color balance and gamma correction .........................................88 
Miscellaneous image options......................................................89 
HPGL and line options ................................................................91 

Modifying Default Settings.....................................................................92 
Changing General Configuration...........................................................93 
Changing global driver settings .............................................................95 
Adding Film Recorder Drivers ...............................................................96 
Managing BLL-Generators ....................................................................97 

Adding a BLL-Generator .............................................................97 
Changing Destination Path .........................................................98 
Deleting a BLL-Generator ...........................................................98 
Using a BLL-Generator ...............................................................98 

Adding Queues......................................................................................99 



 Contents 9 

Deleting Queues....................................................................................99 
Changing Queue Settings .....................................................................99 

Changing the Drop Box Path ......................................................99 
Using Log Files .........................................................................100 
Changing the Queue Port .........................................................100 

Communication Test ...........................................................................101 
Alignment Pattern................................................................................102 

Scanner Helper Dialog ..................................................................................103 

Chapter 8: Networking WinRascol ......................................................................105 
Principle of Operation ....................................................................................105 
Creating a WinRascol Network .....................................................................106 
Keeping print jobs separate...........................................................................107 
Macintosh as Client .......................................................................................108 

Chapter 9: Uninstaller...........................................................................................109 
When to use the Uninstaller ..........................................................................109 
How to use the Uninstaller ............................................................................110 

Chapter 10: Tips and Tricks.................................................................................111 
Specific Image Types ....................................................................................111 

Black and White Bitmap Images .........................................................111 
Color Bitmap Images...........................................................................112 

Printing Images Created for Other Printers ...................................................113 
Specific Applications......................................................................................114 

Adobe Type Manager (ATM)...............................................................114 
Arts & Letters.......................................................................................114 
Corel Draw ..........................................................................................114 
Corel Draw 7 .......................................................................................114 
CorelDraw 8 ........................................................................................115 
Freelance Graphics for Windows Ver 1.0 ...........................................115 



10 Contents 

Freelance Graphics 97 ........................................................................115 
Persuasion...........................................................................................116 
PhotoStyler ..........................................................................................117 
Word, Write..........................................................................................117 

Appendix A: Specifications ................................................................................. 119 

Appendix B: Troubleshooting ............................................................................. 123 
Communication Problems .............................................................................125 

I’m having problems using my film recorder with an Adaptec 2940 type 
controller on Windows NT 4.0 .............................................................125 
I’m having problems attaching my film recorder via SCSI ..................125 
Communication Tests from WinRascol fail .........................................126 
WinRascol cannot detect or communicate with Rascol II or RascolPort on 
Windows 95/98/ME .............................................................................126 
WinRascol RIP cannot detect or communicate with Rascol II ............127 
WinRascol cannot detect or communicate with Rascol IV..................128 
WinRascol cannot detect or communicate with RISCRascol or Film Recorder 
using the parallel port ..........................................................................128 

Error Messages .............................................................................................128 
WinRascol cannot rasterize on PC......................................................128 
PC:  (Error #D1)  Not enough memory for rasterizer to work..............128 
(Error #D3)  Camera is out of film. ......................................................128 
(Error #D4)  Missing or Wrong camera back.......................................128 
(Error #D6) Device communication error ............................................129 
(Error #D75)  Cannot rasterize this image: too complex. ....................129 
Rascol:  (Error #D152)  The film type cannot be used with this film recorder.
.............................................................................................................129 

Output Problems............................................................................................129 
A print job is still not finished after a long time ....................................129 
Text alignment does not match the original ........................................131 
Text and other objects are missing in output ......................................131 



 Contents 11 

Font does not match the original.........................................................131 
Background color does not match the original....................................131 
Few periodic faint horizontal lines .......................................................131 

Miscellaneous Problems................................................................................132 
Image in Dropbox Directory is not added to the queue.......................132 

Glossary 133 

Index 137 
 

 





 Introduction 13 

Chapter 1: Introduction 
 

 

 

This is the user manual for WinRascol 5. This product is used to print images on Lasergraphics film 
recorders from a PC.  

WinRascol 5 supports PCs running Windows 95, Windows 98, Windows 98SE, Windows ME, Windows 
NT 4.0, Windows 2000 and Windows XP. 

Depending on the type of film recorder and the operating system, four types of interfaces can be used: 
the standard parallel port, the Lasergraphics RascolPort, the Lasergraphics Rascol II/IV boards and 
SCSI adapters. Note that not all film recorder types and operating systems support all types of 
interfaces. 

There are three ways to send images to the film recorder: 

•  Adding an image file directly to the print queue. 

•  Using an application (like PowerPoint) to print directly to the film recorder queue. 

•  Adding an image file to a drop box directory 

 

This chapter explains the features of WinRascol. 

� Note: If you are not going to attach a film recorder to your PC, you need to install the Windows 
BLL Generator instead of WinRascol. See the Windows BLL Generator user manual for details. 
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What You Need 
You need the following hardware and software to run WinRascol. 

Required Hardware 
•  Any IBM® PC compatible machine with a Pentium processor or better, Pentium II or better 

recommended. 

•  32 MB of memory when running Windows 95/98/ME, 64 MB when running Windows NT 4.0 and 
Windows 2000 and 128 MB when running Windows XP. Note that this minimum requirement is 
for imaging only. When you want to print from an application like PowerPoint 97, the minimum 
memory requirement is 16 MB for Windows 95/98/ME, 32 MB for Windows NT and 96 MB for 
Windows 2000/XP. 256 MB or more is recommended for professional image manipulation. 

•  Minimum 4 megabytes of disk space for WinRascol programs plus additional storage for 
images. The amount of additional storage required depends on the type of images. Simple 
presentation slides will take between 100 kilobytes to 2 megabytes, complex and high resolution 
slides run from 5 megabytes up to 630 megabytes for true color uncompressible 16000 line  
resolution images. Generally, 100 megabytes of free disk space will be plenty. 

•  A film recorder in the Lasergraphics LFR family. 

•  A standard parallel port, a RascolPort, a Rascol II/IV board (certain film recorder types only, 
Windows 95/98 only) or a SCSI interface card. Note: Not all film recorders support all types of 
interfaces. 

•  High quality cables. 

Required Software 
•  Microsoft Windows 9x/ME, Windows NT 4.0, Windows 2000 or Windows XP operating system. 

•  A Windows application that can print, or a DOS/Windows application that can create files in any 
of the following formats: BLL, HPGL, LL, Photoshop 2.5 (PSD), TARGA, TIFF, DICOMED, 
JPEG, PCX, SGI, PNG or BMP. The Photoshop 2.5 setting can be used to import all current 
Photoshop file formats. 
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About this Guide 
This guide explains how to set up and use the WinRascol software. 

This guide assumes that you already know how to use Microsoft Windows.  If you are new to Windows, 
review your Microsoft Windows User’s Guide before proceeding. 

Screen illustrations in this guide are meant to be representative, not necessarily exact duplicates of 
screens that appear on your video monitor.
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What’s new 
WinRascol 5 replaces WinRascol 4. 

WinRascol 5 offers these advantages over previous versions: 

•  Improved support for Windows NT/2000/XP 

•  Improved default settings handling 

•  Added SGI file format support 

•  Added PNG file format support 

•  Fixed a few bugs 

� Note: Windows 3.1x is not supported in WinRascol 5. WinRascol 3.15 is the last version to 
support Windows 3.1x. 

� Note: Two models of Lasergraphics film recorders are no longer supported in WinRascol 4.1.  
These models are the LFR and LFR Plus film recorders. WinRascol 5 supports the Personal 
LFR model, the Personal LFR Plus model, all LFR-X models, and all Mark-series models. 
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WinRascol Features 
WinRascol  adds a new dimension to all of your visual communications by letting you produce 
professional-quality presentation graphics—right at your desk. 

Various Output Types 
WinRascol takes images produced by any Windows application and prints the images on a 
Lasergraphics LFR series film recorder to make 35mm slides, 35mm prints (negatives), Polaroid prints, 
6x7 cm or 4x5 film transparencies or prints (negatives). 

 

   
 Slides Transparencies 

High Resolution 
With the Lasergraphics Film Recorder (LFR ), WinRascol produces brilliant color images on film.  The 
LFR Mark VI  has a maximum resolution of 16384 lines which produces sharp images with over 700 
times the image resolution (total number of dots in an image) of a VGA screen. 

 

Name Short 35mm resolution 120/220/4x5 resolution Available on 

Fast 2k 2048x1365 2048x1681 All 

Fine 4k 4096x2731 4096x3362 All 

Extra 8k 8192x5461 8192x6724 Mark III and above 

Ultra 16k 16384x10923 16384x13448 Mark VI 
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True Color 
WinRascol supports 24-bit color, which enables you to produce lifelike pictures with any of over 16.7 
million colors.  24-bit color refers to the way color information is stored in the image.  24-bit color is 
sometimes called “true-color” because it reproduces the full range of color visible to the human eye. 

High Speed 
WinRascol is also fast.  Most images are processed in a few minutes.  With this kind of performance, 
WinRascol has the capacity to serve as a high-volume production tool for corporations and service 
bureaus. 
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Easy to Use and Highly Compatible 
WinRascol is compatible with all Microsoft Windows 9x/ME/NT/2000/XP applications that provide the 
Print command.  To print images to WinRascol, you simply invoke the Print command from your 
Windows application.  Images will be sent from your application to WinRascol for processing. 

However, large image files can be printed more efficiently if you let WinRascol process the files directly.  
Bypassing your application, WinRascol can directly process image files in the following formats: 

•  Binary Lasergraphics Language (BLL), a portable Lasergraphics print job format.  WinRascol 
(for Windows) and MacRascol (for Macintosh) can both generate and process BLL files.  Since 
BLL files describe images in a portable form, the source applications and fonts used to create 
the images are not needed when processing BLL files. 

•  HPGL, a popular computer-aided design drawing format. 

•  Lasergraphics Language (LL), a proprietary format for producing graphics on IBM PCs and 
compatibles, minicomputers, and mainframes. 

•  Photoshop 2.5 (PSD), the bitmap file format used by Photoshop 2.5 for Windows and 
Macintosh. The Photoshop 2.5 setting can be used to import all current Photoshop file formats. 

•  TARGA (TGA), a popular bitmap file format for IBM PCs and compatibles. 

•  TIFF, a popular bitmap file format for IBM PCs and compatibles. Often used by scanner 
software. 

•  DICOM, a file format used in medical imaging. 

•  JPEG, a lossy high compression format. 

•  PCX, a popular bitmap file format on the PC platform. 

•  BMP, a popular bitmap file format on Windows systems. 

•  SGI, file format common on Silicon Graphics workstations 

•  PNG, up and coming, lossless and patent-free file format 

 

Allows Film Recorder Sharing on Networks 
WinRascol provides dropbox directories that let a PC user share his film recorder with other PC, 
Macintosh and UNIX workstation users on the network.  The PC with the film recorder acts as a 
WinRascol server by running WinRascol to create and service dropbox directories.  When network 
users put image files in the dropbox directories, the files will be automatically printed on the film 
recorder.
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Chapter 2: Express Setup 
 

 

This section explains how users with previous WinRascol experience can get WinRascol up and 
running quickly. It also points out some new features of WinRascol. If you are new to WinRascol or 
don’t consider yourself a seasoned computer user, please take the time to study the chapters beginning 
with “Chapter 3: Hardware Installation” on page 25. 

 

Installing the Hardware 
Standard parallel port: Make sure to select “Compatible“ or “Standard Parallel“ as the BIOS setting for 
your parallel port. Connect the film recorder to the parallel port using the cable provided by your dealer. 
Note that switch boxes are not compatible with film recorders. Multiple printers can be handled via 
multiple parallel ports, or RascolPort boards. 

RascolPort: Set the RascolPort jumpers to an unused address. Do not set the interrupt jumpers, 
WinRascol does not use interrupt mode. Connect the film recorder to the RascolPort using the cable 
provided by your dealer. Note that switch boxes are not compatible with film recorders. Multiple printers 
can be handled via multiple parallel ports, or RascolPort boards. 

SCSI: Connect the film recorder to your computer using a high quality cable when all devices on the 
SCSI bus are turned off. Make sure to observe cable length limits, especially for Ultra-Fast-SCSI 
systems. Use an active terminator to terminate the SCSI bus if the film recorder is at one end of the 
SCSI chain. Select an unused SCSI-ID for the film recorder. Disable high speed modes of the SCSI 
adapter. Disable synchronous mode as well. Observe 16 bit termination issues on wide SCSI systems. 

Rascol II/IV: Rascol II: Set the Rascol board jumpers to an unused address. Connect the film recorder 
to the Rascol board using the cable provided by your dealer. Rascol IV: Use the reference disk of your 
IBM PC to configure the Rascol IV board. 
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Installing WinRascol 
Run “winrascl.exe“ on the installation CD. Follow the prompts of the setup program. 

Turn on your film recorder. After WinRascol is installed, run WinRascol from the “Start“-Menu. 
WinRascol might prompt you to reboot your system at this time. Restart your computer and rerun 
WinRascol in this case. 

WinRascol will prompt you to supply information about the film recorder and the interface. As soon as 
the film recorder is detected and the queue is installed, WinRascol is ready to use. Use chapter 
“Chapter 7: Reference” on page 63 to find details on how to use WinRascol. 

If you encounter difficulties, refer to the full installation chapters or check “Appendix B: Troubleshooting” 
on page 123 
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Installing Windows BLL Generators 
 

BLL generators are used to generate platform and application independent BLL files that can be used 
for imaging on remote Lasergraphics film recorders. They are only needed to print on a film recorder 
that is not connected to the computer that created the image. 

Lasergraphics provides two methods to generate BLLs from Windows: 

Integrated BLL generator within WinRascol:  Use this on machines running WinRascol with a film 
recorder attached, if you also need to print to remote film recorders. To enable BLL generation, follow 
the instructions under “Managing BLL-Generators” on page 97. 

Windows BLL Generator:  The Windows BLL Generator is a separate, free product requiring no key. It 
is available at no charge from Lasergraphics' web site, http://www.lasergraphics.com. A copy of the 
latest version is also included with WinRascol as a courtesy to those with limited Internet access. You 
may copy and distribute these Windows BLL Generator installation disks. However, note that you may 
not distribute your WinRascol 5 installation disks. 

Please refer to the Windows BLL Generator User Guide for details on how to install and use the 
stand-alone BLL Generator.

http://www.lasergraphics.com/
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Chapter 3: Hardware Installation 
 

 

 

This chapter describes how to install the hardware components of a film recorder system. 

You may only need some of the sections in this chapter. 

� Skip to “Chapter 4: Software Installation” on page 35 if you don’t plan to connect a film 
recorder directly to your system. 

� Most film recorders are shipped to be used with a standard parallel port or a SCSI host 
adapter. Skip to section “Installing the Film Recorder” on page 31 in this case. 
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Installing the RascolPort Hardware 
The RascolPort is an optional device that provides high performance communication to the film 
recorder.  It is very similar to normal parallel ports found on your PC but the RascolPort is much faster 
when used with WinRascol.  

� Skip this section if your film recorder did not come with a RascolPort. 

The RascolPort can be connected to: 

•  A film recorder with parallel interface. Note that some earlier model film recorders don’t support 
the parallel interface but have a DB-25 connector for other purposes. 

•  A RISCRascol with a Parallel Interface Module. 

You can also connect a third party printer to the RascolPort.  The RascolPort can emulate a standard 
bi-directional parallel (LPT) port.  This emulation does not have any speed advantage over a standard 
parallel port. 

� CAUTION:  Connect only a printer or a Lasergraphics Parallel Interface Module to the 
RascolPort.  Nonstandard devices like dongles, parallel network interfaces, and parallel tape 
drives should not be used.  The RascolPort uses “totem-pole” output drivers to achieve high 
speed where a standard parallel port uses “pull ups” and “open-collector” drivers.  Some 
nonstandard devices attempt to back-drive these outputs, which could damage the device or 
the RascolPort.  These outputs are Strobe-, Auto Feed XT-, Init -, and Slct In-.  If the device 
does not drive these lines, then it can be used with the RascolPort. 

The RascolPort may be used in any ISA or EISA 16-bit slot of an IBM Compatible PC.  The RascolPort 
has been designed to run at any I/O bus speed up to 10MHz.  (I/O bus speed is not the same as CPU 
speed.  Most PCs run their I/O bus at about 8MHz.) 
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Installing a RascolPort 
1. Find an unused port address in your PC. 

The RascolPort can use any of the following port addresses: 

 

 Address (hex) Port Comment 

378-37B  P2 Second port searched by DOS 

278-27B  P3 Third port searched by DOS 

358-35B  P4 Not used by DOS 

258-25B  P5 Not used by DOS 

 

� Installing the RascolPort at P4 or P5 is highly recommended and avoid a number of 
complications. To determine whether P4 or P5 is free, you should check the documentation for 
the add-in boards in your system.  That documentation should list “Port Addresses” or “I/O 
Addresses” used by the boards. 

2. Select an unused port for the RascolPort board. 

� CAUTION:  Before handling the RascolPort board, discharge any static electricity from your 
body or clothing by touching a grounded metal object. 

•  Lay the RascolPort board flat on a table in front of you with the components facing up.  Set the 
JP1 jumpers on the RascolPort to a port unused in your PC.  The settings for each port are 
printed on the RascolPort board. 

3. Insert the RascolPort board into an unused slot in your PC. 

You can now install your film recorder by following instructions in the section “Installing the Film 
Recorder” on page 31 in this chapter. 
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Using the RascolPort with a Standard Printer 
In addition to the Parallel Interface Module (at the back of a RISCRascol or film recorder), you can also 
connect a third party printer to the RascolPort.  When not used with Rascol, the RascolPort emulates a 
standard bi-directional parallel port.  This emulation does not have any speed advantage over a 
standard parallel port.  

� CAUTION:  Connect only a printer, a Lasergraphics film recorder or a Lasergraphics 
RISCRascol to the RascolPort.  Nonstandard devices like dongles, parallel network interfaces, 
and parallel tape drives should not be used.  The RascolPort uses “totem-pole” output drivers to 
achieve high speed where a standard parallel port uses “pull ups” and “open-collector” drivers.  
Some nonstandard devices attempt to back-drive these outputs, which could damage the 
device or the RascolPort.  These outputs are Strobe-, Auto Feed XT-, Init -, and Slct In-.  If the 
device does not drive these lines, then it can be used with the RascolPort. 

� NOTE:  When WinRascol is communicating with a film recorder through a RascolPort, it turns 
off parallel port compatibility and places the RascolPort in a special mode.  When WinRascol 
has completed the communication, it returns the RascolPort to parallel port compatible mode.  
If <Ctrl-Alt-Del> is pressed while RascolPort is in special mode, the RascolPort will remain in 
this special mode, DOS will not detect it as a parallel port, and DOS will not give it an “LPT” 
name.  This can be avoided by: 

•  Using the Reset button instead of <Ctrl-Alt-Del>, or 

•  Powering the PC off then on, or 

•  Using the RascolPort only with a film recorder and installing the RascolPort at P4 or P5. 

 

To use the RascolPort with printers, you may need to enable interrupt mode on the RascolPort. JP2 
controls printer interrupts.  WinRascol never uses interrupt mode.  In general, JP2 should be left 
unjumpered.  However, if you are using the RascolPort to connect to devices other than a Rascol, and 
those devices' software require printer interrupts, JP2 can be set for IRQ5 or IRQ7.  The jumper setting 
for each interrupt is printed on the board. 

 



 

 Installing Rascol II and IV Boards 29 

Installing Rascol II and IV boards 
Certain earlier model film recorders required a Rascol II or a Rascol IV board to operate. These boards 
are not sold with current film recorder systems. Skip this section if your film recorder did not come with 
a Rascol II or a Rascol IV board. 

� NOTE: Rascol II and IV boards are only supported under Windows 95 and Windows 98. 
You will need to have your film recorder upgraded by your dealer if you plan to use it 
with Windows NT or Windows 2000. 

The Rascol II is built to be used in any ISA or EISA slot of an IBM Compatible PC. The Rascol II has 
been designed to run at any I/O bus speed up to 11MHz.  (I/O bus speed is not the same as CPU 
speed.  Most PCs run their I/O bus at about 8MHz.) 

The Rascol IV operates in IBM compatible PCs with MCA (Microchannel) slots. 

Installing the Rascol II board 

� CAUTION:  Before handling the Rascol II board, discharge any static electricity from your body 
and clothing by touching a grounded metal object. 

1. Lay the Rascol II board flat on a table in front of you with the components facing up. 

2. Select an unused port address for the Rascol II board by setting the jumpers in the JP2 
block of the Rascol II board according to this table: 

 

Address Port Comment Pos 1 Pos 2 Pos 3 Pos4 

3BC-3BF P1 Usually free Not set Not set Set Set 

378-37B P2 Usually LPT1: Not set Not set Not set Set 

278-27B P3 Usually LPT2: Not set Not set Set Not set 

3F8-3FB S1 COM1: Not set Set Not set Not set 

2F8-2FB S2 COM2: Set Not set Not set Not set 

 

� To determine what port addresses are free, you should check the documentation for the add-in 
boards in your system.  That documentation should list “Port Addresses” or “I/O Addresses” 
used by the boards. 

3. Make sure your PC is turned off. 

4. Insert the Rascol II board into an unused slot in your PC. 
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You can now install your film recorder by following instructions in the section “Installing the Film 
Recorder” on page 31 in this chapter. 

Installing Rascol IV 

� CAUTION:  Before handling the Rascol IV board, discharge any static electricity from your body 
and clothing by touching a grounded metal object. 

1. Turn off your PC and install the Rascol IV board into an unused slot in your PC. 

2. Boot your PC and invoke the System Reference software. 

•  If your PC comes with the System Reference Disk, boot your PS/2 with the System Reference 
Disk. 

•  If your PC does not come with the System Reference Disk, simply hold the CTRL, ALT and INS 
keys down while your PC is booting. 

3. Select the Set Configuration option from the main menu of the PS/2 System Reference Disk 
or setup.  Then choose the Change Configuration option. 

•  When you are prompted to insert the option disk for the Rascol IV into a floppy drive, insert 
WinRascol Disk #2.  

4. Find Lasergraphics Rascol IV on the Configuration screen. 

•  You may need to use the arrow keys to see it. 

5. Select an unused port for Rascol IV. 

•  Leave the Parallel Interrupt disabled. 

6. Save the changes and quit the application. 

7. Reboot your PC as normal (without invoking the System Reference software or setup). 

You can now install your film recorder by following instructions in the section “Installing the Film 
Recorder” on page 31 in this chapter. 
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Installing a RISCRascol 
The RISCRascol is an optional device that allows fast PostScript rasterization for film recorders. 

� Skip this section if your film recorder did not come with a RISCRascol 

 

1. Place the RISCRascol on a smooth, flat surface in a well-ventilated area. 

2. Make sure the Parallel Interface Module or SCSI Interface Module is secured to the back of 
the RISCRascol. 

3. Use a standard printer cable to connect the Parallel Interface Module to a parallel port or a 
RascolPort on your PC. In case of a SCSI connection, use a high quality SCSI cable and 
terminate the RISCRascol if appropriate. 

4. Connect the power cord of the RISCRascol. 

 

Installing the Film Recorder 
 

1. Place the film recorder on a smooth, flat surface in a well-ventilated area. 

� Keep the film recorder away from electrical devices and magnets such as computer monitors, 
power supplies, motors and telephones. 

� If you intend to use the film recorder with a 4x5 camera, you have to take great care to find a 
place that is vibration free. Because of the long focal length of the 4x5 lens the optical path is 
very long and susceptible to mechanical movement. An otherwise unused table on concrete 
floor will do fine. 

2. Connect the film recorder as follows: 

•  Parallel port system: Connect the film recorder to a parallel port using the cable supplied with 
your film recorder. 

� NOTE: Switch boxes are not compatible with film recorders. Multiple printers can be handled 
via multiple parallel ports, RascolPort boards or SCSI. 

•  SCSI system: Make sure both your computer and the film recorder are turned off. Connect the 
film recorder to a SCSI adapter of your PC with a high quality SCSI cable. Note that the film 
recorder has no internal termination and needs to be externally terminated if it is the last device 
in the chain. 
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� NOTE: The total length of a SCSI-1 bus (the sum of the lengths of all the SCSI cabling: internal 
and external SCSI cable) should not exceed 6 meters (15 feet).  This figure assumes the use of 
good quality shielded cable which maintains its characteristic impedance between 90 and 130 
Ohms, and the use of active terminators at each end of the bus. Termination must be present at 
two and ONLY two positions on the SCSI bus, at the beginning of the SCSI bus and at the end 
of the SCSI bus. There MUST be no more than two, and no less than two, terminators on the 
bus. Termination must occur within 10cm (4 inches) of the ends of the SCSI bus. 

� NOTE: Ultra-Fast-SCSI has more stringent requirements on cabling. The maximum cable 
length is 3 meters (9 feet) for SCSI buses containing no more than four SCSI devices (including 
the host adapter) and 1.5 meters (5 feet) for all other Ultra-Fast-SCSI buses. This also applies 
to a film recorder connected to an Ultra-SCSI system, even though the film recorder is a 
standard SCSI-1 device. Please check the documentation of your host adapter for more 
information. It is generally advisable to not have Ultra-Fast-SCSI devices on the same bus as 
SCSI-1 devices. 

� NOTE: Wide-SCSI requires very special treatment of termination when mixing wide (16 bit) and 
non-wide SCSI devices (8 bit). Lasergraphics film recorders, like most other non-hard disk 
SCSI devices, are 8-bit SCSI devices. A Wide-SCSI bus requires full 16 bit termination on both 
ends to operate properly. Standard 8-bit devices cannot be used to terminate a Wide-SCSI bus 
unless a bus conversion with partial termination is implemented. 

 

•  RascolPort: Connect the film recorder to the RascolPort board using the cable supplied with 
your system. 

� NOTE: The high speed film recorder communication is not compatible with switch boxes. 

•  Rascol II or Rascol IV: Connect the film recorder to the Rascol board using the cable supplied 
with your system. 

•  RISCRascol: Connect the film recorder to the RISCRascol with the supplied cable.  Connect 
the RISCRascol to a parallel port on your PC. 
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3. SCSI only: 

•  Select an unused SCSI ID for your film recorder according to this table: 

SCSI ID Switch 1 Switch 2 Switch 3 

0 Off Off Off 

1 On Off Off 

2 Off On Off 

3 On On Off 

4* Off Off On 

5 On Off On 

6 Off On On 

7 On On On 

 

* - factory default 

� NOTE: Most systems reserve SCSI ID 7 for the host adapter. Hard disks generally have low 
SCSI ID numbers. 

� NOTE: Auto-terminating SCSI-adapters like the Adaptec 2940 may require the film recorder to 
be turned on prior to turning on the computer. 

� NOTE: Windows 95/98 requires the film recorder to be turned on prior to booting Windows 
95/98. 

4. If your film recorder has a removable camera, remove the dust covers from the film recorder 
and the camera, mount the camera, lock it in place, and plug in the camera cable. 

5. Connect the power cord and turn on the film recorder. 

6. SCSI on Windows 95/98 only: When Windows 95/98 starts, the operating system may detect the 
film recorder as an unknown device. The Windows 95/98 installation wizard will be started and 
show a dialog with this message: “The wizard will complete the installation of: Unknown Device”. 
Please press Next at this point. Windows will now complain that it was unable to find a plug and 
play driver for the film recorder. That is perfectly ok. Press Finish to let Windows 95/98 use the 
default driver. 

7. Load the camera with film. 
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� NOTE:  The film recorder will not expose any images until it warms up. You can print images 
from your application anytime and the images will wait in the queue.  Once the film recorder is 
ready, the images will be exposed. 

8. If you are connecting the film recorder  to a RISCRascol, turn on the RISCRascol. 

9. You are now ready to install the WinRascol software. 

 



 

 Software Installation 35 

Chapter 4: Software Installation 
 

 

 

This section explains how to install WinRascol on your computer. The installation is performed in two 
steps, the initial WinRascol installation and running WinRascol for the first time. 

WinRascol is the queue management part of the WinRascol package. It is installed in the first step. 

The installation is finished by running WinRascol for the first time. WinRascol will install all required 
printer driver components for the host operating system, change environment (registry) settings as 
required and prompt for more information as needed. 
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Running setup 
These steps perform the initial installation of WinRascol. 

 

•  Close all programs currently running. 

•  Insert the WinRascol installation CD. 

•  Press Start on the Windows tool bar, then select Run. 

•  Browse for WinRascl.exe on the CD. It is in the PC\WinRascol subdirectory. 

•  Press OK. Setup now prepares the installation. 

•  Press Next after reading the introductory screen.  

•  Press Next after reading the readme file. 

•  You will be asked to select a destination directory at this time. It is strongly suggested that you 
use the default directory offered by the installation program. Press Next. 

•  Setup is now ready to install WinRascol. Press Next to install now. 

•  Setup will install all program files at this time. Follow setup’s instructions to insert additional 
disks if needed. 

•  Press Finish to exit setup. 

•  Setup may ask you to reboot your computer in rare cases. 

 

The WinRascol program files are now installed. 
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Running WinRascol for the first time 
Start WinRascol by choosing Start->Programs->WinRascol->WinRascol. When WinRascol runs for 
the first time, it will install some drivers. This may require a restart of the operating system. WinRascol 
will exit and prompt you to restart the system in this case. Please restart Windows, then start WinRascol 
again by selecting Start->Programs->WinRascol->WinRascol. 

WinRascol will now ask you to supply the serial key(s) you received either with your WinRascol 5 
package or by fax: 

 

 

� NOTE: Zero and the letter ‘o’ are treated the same in this dialog to avoid confusion. Case is 
ignored. 

� NOTE: You can also add the Mac key later in File->Edit serial keys. 

If you also own the MacRascol package, enter its serial key as well. Note that you need the MacRascol 
package to image BLLs generated by the Mac BLL Generator version 5 and above. 
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Adding a queue 
WinRascol will show the following dialog to allow you to install a queue. A queue is used to send 
images to the film recorder. At the same time, a printer driver is installed to allow you to print to the film 
recorder from an application. 

The dialog is also displayed when you select New queue in the File menu later on. 

This is the dialog: 

 

 
•  Select the interface type to be used in the Interface type selection box. 

•  Select the detection method in the Detection method selection box. You can select a particular 
port address for all interface types except SCSI. It is recommended to use auto detection. 

� NOTE: Auto-terminating SCSI-adapters like the Adaptec 2940 may require the film recorder to 
be turned on prior to turning on the computer. 

� NOTE: Windows 95/98/ME requires the film recorder to be turned on prior to booting Windows 
95/98/ME when using SCSI. 

•  Select Detect film recorder to find your film recorder on the specified interface. 

•  The Found box then shows the interface name of all detected film recorders. 
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•  Select the film recorder you want to use with this queue by selecting the interface in the Port type 
box. WinRascol will automatically select the first available option. 

 

•  Press Next to move on to the next dialog: 

 

 
 

•  The edit box Queue/printer name contains the name of the queue and the printer driver. 
WinRascol will select a default name for you. 

•  You can make this film recorder queue the new default printer for WinRascol by checking the Make 
this the default printer checkbox. 

•  Press Finish to create the queue and printer. 

If you encounter difficulties, refer to “Appendix B: Troubleshooting” on page 123. 
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Chapter 5: Printing your first image 
 

 

 

This guided tour will show you how to print from an application and how to print a Lasergraphics test 
slide on your film recorder. The tour will work with any film recorder but assumes you are using a 35mm 
camera back. 

You must have completed the hardware and software installation successfully to follow this tour. 
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Printing the Test Slide 
This section will show you how to print the Manytest.ll test slide. 

After WinRascol is started, you should see a screen like this: 
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Now you will need to set the film type. To do this, select View Default Image Settings from the View 
menu. The dialog will look like this: 

 

 
 

Select the Film and Resolution tab, change the Film setting to the film type you are going to use for 
this test. If you intend to use dummy film, you still need to select a film type that would fit into your 
camera. Press OK when you are done. 

Changing the default settings will allow WinRascol to select your film type and other settings every time 
you add a file. 

Prepare your film recorder for imaging now. Turn on the film recorder if you haven’t already done so. 
Put film into the camera and close the camera back. The film recorder may go through warm up at this 
time. Note that this can take up to half an hour.
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Now you need to add the LL test file. It is called Manytest.ll and resides in the WinRascol directory 
where you installed WinRascol. This is usually C:\WINDOWS\LGDATA for Windows 9x computers and 
C:\WINNT\LGDATA for Windows NT computers.  

To add the file, press the  button on the WinRascol tool bar. The following dialog will appear: 

 

 
 

Use the Look in controls to move to the WinRascol directory. Experiment with Files of type. Selecting 
LL files will show only the Manytest.ll test file (and all available subdirectories).  

Select Manytest.ll. Press Add. 
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WinRascol will add the file to the queue and print it after you start the queue with Job->Start Queue. 
Your screen will look like this: 

 

 
 

WinRascol will report the print job as Done after imaging. It will take about 50 seconds to image 
Manytest.ll after the film recorder has warmed up. If the film recorder has not completed the warm-up, 
WinRascol will wait to start exposing the film until warm-up is completed.  
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Printing from an Application 
This section will show you how to print an image using Microsoft Wordpad. Wordpad is included in 
Windows 9x/ME/NT/2000/XP. But you can use any other Windows application instead. 

After starting WinRascol, start Microsoft Wordpad. You will find it in  

Start->Programs->Accessories->Wordpad. 

Punch in a few letters. Wordpad should look like this now: 

 

 
 

Feel free to format the text any way you like! 
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Now open the Wordpad print dialog by selecting Print... from the File menu. 

 

 
 

Select your film recorder in the Select Printer field.  
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Now select Preferences and then Advanced. This will open a dialog that allows you to set film 
recorder print settings: 

 

 
 

This is the Windows XP film recorder settings dialog. The Windows 9x/ME/NT and Windows 2000 
dialogs are shown in the section “Printer settings in Windows NT” on page 75.  

•  Select the film type you intend to use in Film Type.  

•  Select Letter as the page size in Output Size.  

•  Select White as Background Color. Wordpad assumes a white background but doesn’t fully 
paint it. 

•  Press OK. 

•  Now press OK in the Print dialog. The image will be sent to the queue now.
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WinRascol will send the image to the film recorder. WinRascol will have a display similar to this 
one while imaging: 
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Chapter 6: Principle of Operation 
 

 

 

Introduction 
WinRascol consists of two software components: 

•  WinRascol: The queue and print manager. It queues print jobs and sends them to the film 
recorder. WinRascol is the same program on Windows 9x/ME/NT/2000 and XP. 

•  WinRascol Printer Driver: The printer driver is used when you invoke the Print command from 
within a Windows application. Due to architectural differences between Windows 9x/ME, 
Windows NT/2000/XP, there need to be separate printer drivers for each type of operating 
system. 

There are several different ways to use WinRascol: 

•  The user on a PC with a film recorder attached can print by: 

•  Printing directly from an application with the WinRascol Printer Driver, or 

•  Adding image files directly to the queue with WinRascol. 

•  The user on a PC  without a film recorder can: 

•  Print from an application with the Windows BLL Generator to make BLL files, or 

•  Save images in one of the raster formats that WinRascol supports directly. 

BLL and other image files may be put in dropbox directories that are serviced automatically by a PC 
with WinRascol.  If dropbox directories are not accessible, BLL and other image files can be copied to a 
disk and then added to WinRascol on a PC with a film recorder. 
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� NOTE:  Image files in dropbox directories will be automatically deleted after they are printed. 

 

Printing from Windows on a PC with Film Recorder 
Producing slides from Windows applications on a PC with Film Recorder is a simple three-step process. 

•  Select the WinRascol Driver as the output device for your Windows application and configure 
the WinRascol Driver. 

•  Create the images with your application. 

•  Print the images using the Print command from within your application. 

Here is a diagram depicting how this works: 
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Adding Images Directly to a Queue 
On a PC with film recorder, WinRascol lets you add image files directly to the queue as print jobs.  This 
feature allows large image files to be printed more efficiently.  The image types that WinRascol 
recognizes are: 

•  BLL 

•  HPGL 

•  LL 

•  Photoshop 2.5 

•  TARGA 

•  TIFF 

•  DICOM 

•  JPEG 

•  BMP 

•  PCX 

•  SGI 

•  PNG 

 

Here is a diagram showing how this works: 
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54 Principle of Operation 

Printing from Windows on a PC without Film Recorder 
Producing slides from Windows applications on a PC without film recorder is a simple four-step 
process. 

•  Select a BLL-generator Driver as the output device for the Windows application on the PC. 

•  Make sure the BLL-generator Driver is configured to print to a dropbox directory on the network. 

•  Create the images with the application. 

•  Print the images using the Print command from within the application on the client PC. 
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Here is a diagram showing how this works: 
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� NOTE: The dropbox directory can be located on a network server or on the server PC. 

� NOTE: WinRascol does not actually copy files into the queue. Only information about the print 
job is stored in the queue – the image data stays in the dropbox directory. 
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Adding Images Directly to Dropboxes 
PC, Macintosh and UNIX workstation users on the network can print images simply by copying the 
image files to dropbox directories.  The image types that WinRascol recognizes are: 

•  BLL 

•  HPGL 

•  LL 

•  Photoshop 2.5 

•  TARGA 

•  TIFF 

•  DICOM 

•  JPEG 

•  BMP 

•  PCX 

•  SGI 

•  PNG 
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Here is a diagram showing how WinRascol Network Version processes image files in a dropbox 
directory: 
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� NOTE: Files added to the dropbox are deleted automatically after successful imaging. 
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Important Concepts 
This section explains resolution, color fidelity, and the differences between bitmaps and objects. 

Resolution 
Resolution can be defined in many ways.  Dots per inch (DPI) is a common definition, but an impractical 
one for slides and overhead transparencies because the DPI changes significantly when the image is 
projected. 

The most practical definition of resolution is the total number of dots (or pixels) in the image.  The 
following table compares the image resolution of several graphics output devices. 

 

Device Dots Image Resolution approx. DPI 

VGA screen 640 by 480 307,200 58 (on 17” CRT) 

Most laser printers 2400 by 3276 7,862,400 300 

All LFR film recorders 4096 by 2731 11,186,176 2790 (on 35mm film) 

LFR Mark III, Mark V 8192 by 5461 44,736,512 5945 (on 35mm film) 

LFR Mark VI 16384 by 13438 220,168,192 11890 (on 35mm film) 

 

Images produced by the LFR Mark VI contain over 716 times more dots than images on a VGA screen. 
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When discussing film recorder resolution, the terms 2000-line slide, 4000-line slide and 8000-line slide 
are commonly used.  The number of lines refers to the number of dots across the image. Examples: 

2000-Line Slide 4000-Line Slide 8000-Line Slide

 
 

� NOTE: High end Lasergraphics film recorders can image up to 16384x13448 dots. This is 
called 16000 line resolution. Some camera backs have a different aspect ratio that enables the 
film recorder to output at higher vertical resolution like 4096x3362. This is still called 4000 line 
resolution.  

 

Color Fidelity 
Color fidelity refers to the range of colors that can be reproduced in an image. 

The range of colors that can be represented is defined by the number of bits per pixel used to store an 
image.  The more bits per pixel, the greater the range of colors. 

WinRascol supports 24-bits per pixel, 8 for each of red, green, and blue.  This results in 256 shades of 
each primary color, which can combine to form 16.7 million colors.  Each pixel in an image can be a 
different color. 



60 Principle of Operation 

Bitmaps and Objects 
Images can contain bitmaps, objects, or both.  Bitmaps consist of dots or pixels. Objects consist of 
mathematical descriptions of a shape, such as a polygon or line.  Applications that create bitmaps are 
often called “paint” programs and those that create objects are often called “draw” or “illustration” 
programs.  Both graphics and text can be bitmaps or objects.  

Graphics 
At high resolution, bitmaps look the same if the film recorder resolution exceeds the resolution of the 
bitmap but objects get sharper. 

You can usually tell bitmaps from objects by watching how the image is created when it is first displayed 
on the screen.  Bitmaps are usually drawn on the screen from top to bottom in one chunk.  Objects are 
assembled in pieces. 

Text 
Text can be a bitmap or an object, just as graphics can.  Text that is part of a bitmapped graphic with 
lower than film recorder resolution remains jagged at high resolution.  However, text that is an object 
can get sharper when output at high resolution. 

Text created with ATM (Adobe Type Manager) or TrueType fonts are sharp at any size and resolution.  
In addition, ATM and TrueType fonts will look the same on screen as on the slides printed by 
WinRascol. 
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Which Applications Create Bitmaps or Objects 
Most images contain either bitmaps or objects, but some images can contain both.  Here are some of 
the more popular applications: 

 

Bitmaps 

•  Adobe® Photoshop TM 

•  Aldus® PhotoStyler TM 

•  Microsoft® Paint 

•  ZSoft Corp. Publisher's Paintbrush® 

 

Objects 

•  Aldus® PageMaker® 

•  Aldus® Persuasion® 

•  Computer Support Corp. Arts & Letters® 

•  CorelDRAW!® 

•  Harvard® Draw 

•  Harvard Graphics® 

•  Lotus Freelance Graphics® 

•  Micrografx® Charisma TM 

•  Micrografx® Designer TM 

•  Microsoft® PowerPoint® 

•  Microsoft® Excel® 

Images from these applications may contain bitmaps that have been imported. 

 

Both 
•  Deneba CanvasTM 

•  CorelDRAWTM 

•  PowerPointTM 

•  Lotus FreelanceTM 
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Chapter 7: Reference 
 

 

This chapter provides detailed information about WinRascol components. 

Printer Settings 
Many WinRascol components will let you modify a wide variety of imaging options. This section 
explains these options in detail. Later sections will explain where these options apply and how to 
access them. 

Resolution 
Resolution controls the number of dots in the image according to the following table: 

 

Name Short 35mm resolution 120/220/4x5 resolution Available on 

Fast 2k 2048x1365 2048x1680 All 

Fine 4k 4096x2731 4096x3360 All 

Extra 8k 8192x5461 8192x6719 Mark III and above 

Ultra 16k 16384x10923 16384x13438 Mark VI 
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Note that the time it takes to image a slide will increase with the resolution setting approximately as 
follows: 

 

Resolution 2k 4k 8k 16k 

Relative resolution 0.25 1 4 16 

Relative imaging time 0.75 1 4 16 

Approximate imaging time 30s 40s 150s 600s 

 

Relative resolution is the total number of pixels relative to a 4k slide. 

Relative imaging time is the time it takes to image relative to a 4k slide, on a theoretical basis. 

Approximate imaging time is the time it minimally takes to image a slide in real life. 

Orientation and Paper Size 
Orientation specifies whether the output should be in Landscape or Portrait mode. 

 

 
Landscape

 
Portrait 

 

Paper size determines the paper dimensions returned to the application.  

� NOTE: Paper size does not correspond to the actual size of the film. 

� NOTE: Make sure to match the paper size and orientation settings of the printer driver with 
those of your application. Some applications will ignore paper dimensions returned by the 
printer driver. Paper size and orientation mismatches can lead to badly sized images. 
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Film Type 
•  Film Type specifies the type of film in the camera back connected to the film recorder. The 

specific film information is stored in so-called LFC files stored in the WinRascol\LFC directory. 
These LFC files contain transfer functions for specific film/film recorder combinations. 

 

LFC-based Film Types 
LFCs support a variety of film types such as Kodak Gold 100 Plus, Vericolor III, etc. Each 
Lasergraphics Film Calibration file provides calibration data for one film on one specific film recorder 
model. For example, the 35mm Vericolor III LFC file for LFR Mark III will be different from the one for 
LFR Mark III - Digital Photography Model. 

Background Color  
Background Color specifies the background color of the image.  This setting is ignored if the 
application explicitly sets the background color in the image. Use Background Color to set the color of 
unpainted regions to white for text applications like Word. Otherwise, you might end up with black text 
on black background! 

Scaling 
Scaling controls how the image is scaled for output.  100% keeps the image size unchanged.  To 
shrink the image, set the value to less than 100%.  To expand the image, set the value to greater than 
100%.  The range of valid scaling values is 20% to 400%. 

Antialiasing 
Antialiasing reduces the jaggies on sharp edges and lettering in images at the cost of significantly 
longer processing time.  (In general, antialiasing may be more effective for Fast resolution non-bitmap 
images.  On bitmap images, antialiasing offers almost no improvement.)  Selecting None will disable 
antialiasing.  Level 2 antialiasing produces images of better quality than Level 1 but the processing 
time is also longer. 

Minimum Exposure Time 
This setting  applies mostly to very old film recorders that have no internal slice mark control 
mechanisms. Minimum Exposure Time controls the exposure time of the film recorder to eliminate slice 
marks (periodic faint horizontal lines) on the output.  Normally Fastest Possible should be selected.  If 
there are slice marks on the output slide, set the minimum exposure time to 1.5 times the normal 
processing time of the image.  If slice marks are still there, increase the value and try again. 
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Color Balance 
Color balance controls the percentages of red, green and blue used in the film recorder.  Normally, 
each of the three colors is set to 100%.  The range of valid color balance values is 25% to 400%. 

Contrast Gamma 
Contrast Gamma allows for very fine contrast adjustment.  The range of valid gamma contrast values 
is 0.14 to 7.0.  However, values between 0.25 and 2.0 are usually more practical.  By adjusting the 
gamma contrast value you can change the midtones of the image without affecting the highlights.  As 
the gamma contrast value decreases, output midtones become darker.  As the gamma contrast value 
increases, output midtones become lighter. 

The graph under the scroll bar for gamma contrast adjustment (only available in some dialogs) shows 
how input intensities are mapped to output intensities.  The horizontal axis represents input intensities 
which increase from left to right.  The vertical axis represents output intensities which increase from 
bottom to top. 

Pen Colors 
Using this option you can set the eight pen colors  for HPGL print jobs. 

Plotter Emulation 
This option allows you to change the emulation type of HPGL print jobs. You can choose from the 
following emulations: 

•  HP 7440A 

•  HP 7470A 

•  HP 7475A 

•  HP 7510 

•  HP 7550A 

•  IBM 7371 

•  IBM 7372 

7475A and 7550A are the preferred emulations. 
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Line Thickness 
This option allows you to change the default line thickness of HPGL print jobs. You can choose from the 
following options: 

•  Default Line Thickness 

•  0-7 pixels 

Rotation 
The rotation setting allows you to control how raster files are oriented. There are five settings: 

•  None – disables rotation. 

•  Auto – allows WinRascol to choose the rotation setting for you to match the aspect ratio of the 
image with the aspect ratio of the film. 

•  90 degrees CCW - rotates the image 90 degrees to the left. 

•  180 degrees – turns the image upside down. 

•  90 degrees CW – rotates the image 90 degrees to the right. 

� Note: Rotating images can be a very time consuming task. To improve performance you might 
want to increase the rotation buffer size. Check “Changing General Configuration” on page 93 
for details. 

 

Interpolation 
The interpolation setting is used to enable interpolation of low resolution raster files. This is useful to 
prevent low resolution rasters from becoming blocky when imaged on a high resolution film recorder. 
Note that this option is quite processor intensive and may increase imaging times.
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Using the Windows 9x/ME driver 
Printing a document or image to a film recorder from an application is just like printing to any ordinary 
printer. This process will vary slightly from application to application, but generally the Print command in 
the application’s File menu will do the trick. 

 

Printer settings in Windows 9x 
The printer driver allows changing a number of print settings. Most of these settings don’t need to be 
changed in many cases, but you will always need to select the film type you want to use. The Print 
dialog generally has a button that allows you to access the printer settings dialog. 

Please see “Printer Settings” on page 63 for details on individual settings.
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This is the printer settings dialog in Windows 9x.  

 
•  Choose the desired resolution in the Resolution box. Note that not all film recorders and film 

types support all resolutions. Up to four different resolutions are available: 

•  2k – Fastest selection – up to 2048 x 1680 pixels 

•  4k – Fine resolution – up to 4096 x 3360 pixels 

•  8k – Extra fine resolution – up to 8192 x 6719 pixels 

•  16k – Ultra fine resolution – up to 16384 x 13438 pixels 

Note that the higher the resolution, the longer it will take to print the image on the film recorder. As 
a rule of thumb, 2k images will take at least 30 seconds, 4k images will take at least 40 seconds, 
8k images will take at least 150 seconds and 16k images will take at least 600 seconds. The exact 
times will vary with the complexity of the image, the speed of the interface, the film type and the 
type of film recorder used. 
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•  Orientation selects the image orientation. 

•  Output Size selects the “paper” format to use. This should match the paper format selected in 
your application. You will generally get best results with the default “Standard Slide”. You can 
also select a user defined paper size 

� NOTE: Make sure to match the paper size and orientation settings of the printer driver with 
those of your application. Some applications will ignore paper dimensions returned by the 
printer driver. Paper size and orientation mismatches can lead to badly sized images. 

•  Film selects the film to use. 
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Color balance and gamma correction 

 
 

•  Color Balance controls the brightness of the three color channels. 

•  Gamma Correction controls the gamma correction. It is used to brighten or darken mid tones 
of an image without changing the very dark and very bright pixels. 
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Miscellaneous options 
 

 
 

•  Compression selects a compression type for the BLL. Medium compression optimizes for 
speed, while high compression optimizes for file size. Use high compression when you want to 
send BLLs to a service provider using removable media or the Internet. 

•  Scale scales your image. The range is 25% to 400%. Note that scaling your image may result in 
non-optimal use of film. 

•  Exposure Speed is used to lengthen the imaging time in rare cases of slice marking. 
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•  Background Color selects the color that is used to paint the background. This color is used in 
cases where the application does not specify a background color and when the aspect ratio of 
the paper selected in the application doesn’t match the aspect ratio of the film. 

The options Pixel Aspect Ratio, Raster Options and Anti-Aliasing don’t apply for non-raster 
operation. 
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Changing the Default Printer Settings in Windows 9x/ME 
The document default printer settings are used automatically when an application initializes the printer 
settings of a document, usually when a document is created and when the selected printer is changed. 
By setting the document defaults to the settings you normally use, you can simplify using the printer 
driver. 

You can find the default document settings by: 

 

Selecting Start->Settings->Printers 

right-clicking on the film recorder 

selecting 'Properties’->’Details’->’Setup’ 

 

The default document settings dialog is the same as the printer settings dialog described in “Printer 
settings in Windows 9x” on page 68. 
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Using the Windows NT/2000/XP driver 
 

 

Printer settings in Windows NT, Windows 2000 and Windows XP 
Printing a document or image to a film recorder from an application is just like printing to any ordinary 
printer.  This process will vary slightly from application to application, but generally the Print command 
in the application’s File menu will do the trick. 

The printer driver allows changing a number of print settings. Most of these settings don’t need to be 
changed in many cases, but you will always need to select the film type you want to use. The ‘Print” 
dialog generally has a button that allows you to access the printer settings dialog. 

Please see “Printer Settings” on page 63 for details on individual settings. 

The dialogs shown in this section are from Windows XP. The Windows NT and 2000 dialogs are similar 
in nature. 
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The printer settings dialog looks like this: 

 

 
 

•  Selecting Paper Size: Select 'Paper/Output' in the upper window, then choose a form in the 
lower window. Default is 'LFR Standard Slide 7.33x11in'. 

•  Selecting Orientation: Select 'Orientation' in the upper window, then choose 'Portrait' or 
'Landscape' in the lower window. The driver will rotate the rasterized image to fit the form on the 
film using as much film as possible. Default is 'Portrait'. In some operating systems this option is 
shown in the previous dialog. 

•  Selecting Resolution: Select 'Resolution' in the upper window, then choose 2k, 4k, 8k or 16k in 
the lower window. Note that not all film recorders support all resolutions. Default is 4k.  

•  Selecting Background Color: Select 'Background Color' in the upper window, then choose 
'black' or 'white'. The background color determines the color imaged on film for areas that the 
application decides not to rasterize on. The background color is also applied to areas that are 
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not imaged by the application due to the fit of the form on the film. Options are black and white. 
Default is black. Select ‘White’ for text applications like Word that expect white paper. 

•  Selecting Exposure Speed: Select ‘Exposure Speed' in the upper window, then choose a 
minimum exposure time in minutes. This setting selects the minimum time for the exposure. It is 
used to slow down the film recorder in rare cases of banding. Default is 0 for maximum speed. 

•  Selecting Gamma Correction: Select 'Gamma Correction' in the upper window, then choose a 
gamma value between 0.144 and 7. Default is 0.500. 

•  Selecting Color Balance: Select 'Red', 'Green' or 'Blue' in the upper window, then set a 
balance value between 25 and 400. Default is 100 for red, green and blue. 

 

 

Storing Changed Settings 
Press OK to store changed settings. 'Cancel' will undo all changes. 
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Changing the Default Printer Settings in Windows NT/2000/XP 
The default document settings are used automatically when an application initializes the printer settings 
of a document, usually when a document is created and when the selected printer is changed. By 
setting the document defaults to the settings you normally use, you can make your life easier. 

You can find the default document settings by: 

 

Selecting Start->Settings->Printers 

right-clicking on the film recorder 

selecting 'Document Defaults…' 

 

The default document settings dialog is the same as the printer settings dialog described in “Printer 
settings in Windows NT” on page 75. 

Please see “Printer Settings” on page 63 for details on individual settings. 
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Using WinRascol 

Starting WinRascol 
Select Start then WinRascol in the WinRascol menu. 

Exiting WinRascol 
Select Exit in the File menu. 

Adding Print Jobs to a Queue 
There are three ways to add print jobs to a queue manually. You can use the “Add file” dialog, you can 
use the Windows concept of “drag and drop” or you can paste files from the clipboard. 

You can add files of these types: 

•  BLL – files generated by BLL-generators 

•  HPGL – HP plotter format 

•  LL – Lasergraphics graphical primitive format 

•  Photoshop 2.5 (PSD) 

•  TARGA – a common bitmap format 

•  TIFF – a common scanner output format 

•  DICOMED – a format used in medical imaging 

•  JPEG – lossy compression format for photorealistic images 

•  PCX – ancient PC raster file format 

•  BMP – common Windows file format 

•  SGI – Silicon Graphics image format 

•  PGN – Portable Network Graphics file format 
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Add Job 
You can access the “Add Job” dialog box by either selecting Add in the Job menu or by pressing the 

 symbol from the tool bar. The “Add Job” dialog box looks like this: 

 
If you are not familiar with this standard Windows dialog, please refer to your Windows documentation.  

After selecting the directory that contains the file(s) you want to add, you can filter out a certain type of 
file with Files of type. 

The Open as type box allows you to determine WinRascol’s strategy of determining file type. In 
“Autodetect” mode, WinRascol will attempt to determine the type of the file on its own. If this fails, you 
will be prompted to choose a type for each file. You can also predetermine the file type if you select the 
file type directly in Open as type. 

The Copies field allows you to set how many copies of this file you want to make. 

Select one or more files in the file window and press Add to add them to the queue. 

Press Cancel to abort the Add file dialog. 
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Drag and Drop 
You can add files to a queue by using the Windows concept of drag and drop. To do this, you left-click 
on one or more files on the desktop or in an explorer window. While holding the mouse button, you 
move (drag) the files over the queue window. When you let go of the mouse (drop), the files are added 
to the queue automatically. 

WinRascol will attempt to auto-detect the types of the files that are being dropped. If this fails, you will 
be prompted to supply the correct file type. 

 

Adding jobs using paste 
You can add print jobs to a queue by pasting (Job->Paste) files from the Windows clipboard into a 
WinRascol queue. The files will usually have been copied to the clipboard in an Explorer window. 
WinRascol will attempt to auto-detect the file type and prompt for more information if necessary. 
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Managing Print Jobs 
This section explains how print jobs in the queue and the queue itself can be managed. 

Starting and Stopping a Queue 
All queues are started by default when you start WinRascol. Queues will stop when fatal errors are 
encountered. All errors except “Out of film” are considered fatal. 

To restart a queue after it has been stopped either select Start Queue in the Job menu or push the 
green button on the tool bar. 

To stop a running queue either select Stop Queue in the Job menu or push the red button on the tool 
bar. If a queue is currently exposing an image you will be asked whether you want processing stopped 
immediately or after the image is done. 

Checking Print Job Status 
You can review error messages of print jobs by right-clicking on the Status column. WinRascol will 
remember error messages returned by the film recorder and rasterization engine until the print job is 
printed again. 

Changing Print Job Status 
You can change the status of a Print Job in the Status column by left-clicking on the status of the print 
job. The status will change as follows: 

 

Current Status New Status 

Waiting Hold 

Done Waiting 

Hold Waiting 

Error Waiting 

 

� NOTE: This operation can be used on multiple print jobs. Please refer to “Selecting Print Jobs” 
on page 83 for more information on how to select multiple print jobs. 



 

 Using WinRascol 83 

Displaying/hiding Print Job Columns 
You can display/hide most print job information columns of a queue by selecting the corresponding 
entry in the View menu. You can display/hide the following columns: 

•  Anti Alias 

•  Aspect Ratio 

•  Color Balance 

•  Copies 

•  Cropping 

•  Line Thickness 

•  Plotter Emulation 

•  Exposure Speed 

•  Film Type 

•  Gamma Correction 

•  Resolution 

•  Scaling 

•  Size 

•  Time 

•  Rotation 

•  Interpolation 

 

Selecting Print Jobs 
You will need to select print jobs in order to perform certain operations on them. To select a single print 
job simply left-click on its name in the Job column. 

To select multiple print jobs do one of the following: 

•  Select multiple jobs by left-clicking on the name of each of them while holding down the Ctrl-
Key. 

•  Select one job by left-clicking on its name. Depress the Shift-Key and click on another job. All 
the jobs between the first and the last job you clicked on will be selected, including the jobs you 
clicked on. 

•  Select all jobs by selecting Select All in the Job menu or by pressing Ctrl-A. 

You can now operate on all selected jobs simultaneously. 
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Moving Print Jobs 
You can move print jobs in two ways: 

•  By selecting one or more print jobs and selecting Move to Top in the Job menu or pushing the 

 button from the tool bar. This will move the selected print jobs to the top of the queue, they 
will be printed first. Note that jobs that are being printed cannot be moved. 

•  By selecting one or more print jobs and dragging them to the desired position in the queue. To 
do this, left-click on one of the selected jobs then move (drag) the mouse to the desired position 
while holding the mouse button. When you release the mouse button (drop), the print jobs will 
be moved to the new position in the queue. Note that jobs that are being printed cannot be 
moved. 

Please refer to “Selecting Print Jobs” on page 83 for more information on how to select multiple print 
jobs. 

Deleting Print Jobs 
Select one or more print jobs and do one of the following: 

•  Press  on the tool bar. 

•  Select Delete in the Job menu. 

Please refer to “Selecting Print Jobs” on page 83 for more information on how to select multiple print 
jobs. 

Previewing Print Jobs 
To preview BLL, LL, TARGA, TIFF, PSD, JPEG, BMP, SGI, PNG and PCX type print jobs, right-click on 
the name of that print job. Select Preview. A preview window will open and the image will be generated 
inside of it in real time. 

You can use left-clicks to magnify and right-clicks to shrink the previewed image. 

� NOTE: Some graphics boards will not perform magnification/reduction operations on large 
bitmaps well. Symptoms observed with some boards: Sluggish performance, incorrect display 
of bitmap, no display of bitmap, graphics board driver crash. 

� NOTE: The preview window requires 16 bit graphics mode or better in order to display colors 
correctly. Lower pixel resolution will result in an unsatisfactory approximation of colors. 

To end the preview, close the preview window. 

Previewing  Print Jobs with Explorer 
You can preview PC-generated BLLs by double clicking on a BLL file in Explorer. 
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Changing Print Job Settings 
Left-click on the information column of the job you want to modify. 

Please see “Printer Settings” on page 63 for details on individual settings. 

You can change the settings of a print job by left-clicking on any of the setting displays in the queue, 
except for “Status“. This will bring up the settings dialog. It consists of four pages that can be accessed 
by clicking on the tabs at the top of the dialog. 

Use Default  to set defaults for all job settings. 

Press OK to save changes made to the job settings. 

Press Cancel to undo any changes made to the job settings. 

Note: Not all settings are applicable to all file types. The settings that don’t apply to a particular job will 
be grayed out and uneditable. 
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Film and Resolution 
Open this page by clicking on the Film and resolution tab of the dialog. 

 

 
 

•  Film selects the film type to use. 
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•  Choose the desired resolution in the Resolution box. Note that not all film recorders and film 
types support all resolutions. Up to four different resolutions are available: 

Name Short 35mm resolution 120/220/4x5 resolution Available on 

Fast 2k 2048x1365 2048x1680 All 

Fine 4k 4096x2731 4096x3360 All 

Extra 8k 8192x5461 8192x6719 Mark III and above 

Ultra 16k 16384x10923 16384x13438 Mark VI 

 

Note that the higher the resolution, the longer it will take to print the image on the film recorder. 
As a rule of thumb, 2k images will take at least 30 seconds, 4k images will take at least 40 
seconds, 8k images will take at least 150 seconds and 16k images will take at least 600 
seconds. The exact times will vary with the complexity of the image, the speed of the interface 
and the type of film recorder used. 

•  Copies selects the number of copies to make of the slide. You can also override the “copies“ 
setting of BLLs by setting a value higher than 1. If the value is 1 the “copies“ setting in the BLL 
will be used. 
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Color balance and gamma correction 
Select the Color balance and gamma correction tab to see this page: 

 
 

•  Use the Color Balance box to change the brightness or the color relations of a slide. You can 
change any setting by either entering a percentage in an edit box or by moving the slider with the 
mouse. The minimum percentage for any of the four settings is 25%. The maximum percentage is 
400%. The default is 100% for all four settings. Note that not all film recorders will be able to image 
a slide at maximum brightness. This is a technical limitation to prevent CRT burnout. 

•  Gamma Correction is used to modify the contrast of the slide. It changes the transfer function that 
combines the input pixel value with the density on the film. The minimum value is 0.145. The 
maximum value is 7. The default value is 0.5. 
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Miscellaneous image options 
Select the Misc. image options tab to see this page: 

 
 

•  Use Pixel Aspect Ratio to select the aspect ratio of pixels of bitmap files. The minimum is 0.001. 
The maximum value is 1000. The default is 1. 

•  Use Cropping to select how WinRascol deals with bitmap files that don’t perfectly fit the resolution 
of the film recorder.  The default is Best fit. 

•  Select Best fit to scale the image so that all of it fits on the slide. The remaining space is filled 
using the background color. 

•  Select Fill frame to use all of the slide by cropping parts of the bitmap. 

•  Use Rotation to select if and how raster images are rotated. Default is auto. 
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•  Use Interpolation to reduce the blockiness of low resolution raster images. 

•  Use Scaling to change the scale of an image. The minimum value is 25%, the maximum value is 
400%. The default is 100%. 

•  Use Exposure Speed to force a longer film exposure. This is used to avoid banding in severe 
cases. The default is Fastest. 

•  Use Background Color to set the background color of the slide. This background color is only 
visible when the image does not use the entire frame or doesn’t draw on the entire slide (in the 
case of HPGL and similar formats). The default is black for all files except HPGL where it is white. 

•  Use Anti Alias to make high contrast lines look smoother. The default value is No antialiasing. 
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HPGL and line options 
Select the Misc. image options tab to see this page: 

 
•  You can modify individual pen colors for HPGL jobs by clicking on the Change button next to 

one of the eight pen colors. 

•  Select the plotter to emulate in the edit box of the same name. This will change the behavior of 
the raster engine for HPGL print jobs. 

•  Select the thickness of lines drawn in HPGL print jobs in the edit box of the same name.
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Modifying Default Settings 
The default settings used for jobs that are added to a queue. Select View->Default Image Settings. 

A dialog will be displayed to allow you to view and modify the settings. This dialog is the same as the 
one seen in “Changing Print Job Settings” on page 85 and below. Note that these settings do not apply 
to images printed from applications. 

Press OK to store the changes. Press Cancel to nullify any changes you made. 



 

 Using WinRascol 93 

Changing General Configuration 
Open the General configuration dialog by selecting General Configuration in the file menu. The 
dialog looks like this: 

 
•  Periodic scan time: This is the interval between scans of the drop box directory in seconds. 

You may choose to change this setting in networking environments where the periodic scan 
imposes too much of a drain on network bandwidth. The default is one second. 

•  Enable print job auto deletion: Print jobs that were added to the queue through the printer 
driver or as a drop box entry are deleted by WinRascol after they were successfully imaged 
when this flag is enabled. You can disable this feature by removing the check. The default is 
enabled. 

•  Auto start queues: You can prevent WinRascol from auto-starting queues at program startup 
by not checking this flag. The default is disabled. 

•  On the fly rotation buffer: Increase this setting to improve the performance of raster rotation 
operations. Note that this setting is only used for rotations.  

•  Raster buffer size: You can set the amount of memory the secondary rasterizing engine uses 
to raster images. Use this option to enable WinRascol to rasterize complex LL and BLL files. 
You can set this value to the lowest setting of 512 for standard operation. If you run into trouble 
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imaging certain LL or BLL files (Error 1: “Not enough memory for rasterizer to work”), set this 
option to a higher value. The default value is 2048. 

•  Queue block time: This is a networking feature. Use this setting in multi user environments to 
block a queue for the selected number of minutes before any other jobs can be processed. This 
is done to avoid getting a jumble of slides from different people on a roll of film. If you expect 
that it may take longer for images to be dropped off than it will take to image them while other 
users add files to other queues at the same time you should make use of this option.  

•  Enable unattended operation features: When checked, this option enables the following 
behavior: 

•  Suppresses a number of errors, especially image file specific errors like “Illegal Targa 
format”. 

•  Forces the default BLL film type whenever BLLs are added to the queue. 

•  Enable job numbers: This flag enables the display of consecutive numbers in front of the job 
names. Default is disabled. 

•  Enable sounds: Enables/disables warning sound when errors occur. 
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Changing global driver settings 
Open the Global driver settings dialog by selecting Driver configuration in the File menu. The dialog 
looks like this: 

 
•  Minimum free: The printer driver checks for remaining disk space on the destination medium 

before writing to it. If the minimum specified in this dialog is not met, the printer driver will stop 
imaging and display a dialog until more disk space is available. The default is 1 MB. You may 
want to increase this setting to 50 or 100 to avoid various problems, if you have adequate disk 
space available. 

•  Enable Power Smoothing Technology: This option enables a post processing feature that 
attempts to correct a gradient fill problem of PowerPoint 97. Gradient fills printed from 
PowerPoint 97 have very coarse steps and exhibit visible banding on high quality film recorders. 
This option interpolates between bands to ease the effect. 

•  Enable Lotus Freelance Workaround: This switch enables a workaround for a bug in Lotus 
Freelance 97. Freelance 97 will preview and print in black and white on true color printers. 
Enabling this switch hides the fact that Lasergraphics film recorders are true color devices from 
applications.  

� Note: Enabling this switch may affect printing from other applications adversely.  

� Note: Lotus will try to fix this problem in future releases. 

 

Select OK to save any changes you made. 

Select Cancel to undo any changes. 
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Adding Film Recorder Drivers 
Printer drivers for the film recorders are added and deleted with queues. There is no need to manage 
printer drivers separately. Please refer to “Adding Queues” on page 99, “Deleting Queues” on page 99 
and “Changing Queue Settings” on page 99 for details on how to manage queues. 
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Managing BLL-Generators 
A BLL generator is a tool to generate BLL files. BLLs are a transportable format of film recorder images 
that include all film recorder settings, fonts and other application specific data. BLLs are used to transfer 
images to service bureaus and to transfer images over a network. 

Open the BLL management dialog by selecting BLL-generator Configuration in the File menu. The 
dialog looks like this: 

This is the dialog: 

 

Adding a BLL-Generator 
•  Select Add generator. The following dialog is displayed: 

 
•  Select the destination film recorder type in Film recorder type. 

•  Enter the serial number of your film recorder in the Serial number edit box. 

•  You can modify the name of the printer driver in the edit box Driver name. WinRascol will select a 
default name for you. 
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•  Select the Destination directory in which the BLL files will be placed. WinRascol will select the 
default temporary file path as default. You may select the network path of a WinRascol drop box if 
you intend to use a film recorder that is connected to your network. 

Drop boxes enable a PC, serving as an LFR print server, to detect and image the BLL file on the fly.  
You may also select a directory to simply hold the BLL files for later use. 

•  Check the Default Printer check box if you want the BLL generator to be your default printer driver. 

•  Press OK to create the BLL driver. 

The BLL driver will now appear in the BLL-generator Administration dialog. 

Changing Destination Path 
Select Change Path in the BLL generator administration dialog. A dialog will appear to allow you to 
change the destination path. The destination path points to the directory in which generated BLLs are 
placed. 

Deleting a BLL-Generator 
Select a BLL driver in the BLL generator administration dialog by clicking on it. Press Delete generator. 
The BLL-generator will be deleted. 

Using a BLL-Generator 
Use a BLL-generator by selecting it as a printer from your application just like queue bound drivers. 
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Adding Queues 
To add another film recorder queue, select New Queue in the File menu. Refer to “Adding a queue” on 
page 38. 

� NOTE: You can have as many queues as you like. More than one queue can point to the same 
film recorder. However, only one queue can actually image at a time. Other active queues will 
wait for the imaging queue to finish before starting. 

� NOTE: Each queue needs to have a unique name.  

� NOTE: Adding a queue to WinRascol also adds a Printer to the system.  All printers must have 
unique names.  You may need to shorten printer names for compatibility with some 
applications. 

Deleting Queues 
To delete a film recorder queue, activate the queue’s window in WinRascol and select Delete Queue 
from the File menu. The queue will be deleted. 

� NOTE: A queue needs to be stopped before it can be deleted. 

� NOTE: WinRascol will delete all print jobs in that queue, the queue directory and the associated 
printer driver when a queue is deleted. 

Changing Queue Settings 
There are two places to change queue settings. 

Changing the Drop Box Path 
The drop box path points to the directory where WinRascol will look for added files. Files added to this 
directory will be shown in the queue, imaged and then deleted. 

Select Queue configuration from the File menu. A dialog that lets you change the drop box path will 
appear.  

� NOTE: Changing the drop box path is an advanced option usually needed to build WinRascol 
networks. 

� NOTE: When you change the drop box path of a queue and still want to use the associated 
printer driver there will need to be a directory called BLL in the drop box directory. WinRascol 
will attempt to create this directory on its own, but may fail if you have assigned insufficient 
rights to WinRascol at the time. 
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Using Log Files 
Log files are used to keep an eye on unattended film recorder systems. You can enable/disable the log 
file of a queue in the Queue configuration dialog. Select Queue configuration from the File menu to 
find it. 

The log file will be created in the “LGDATA\Q” directory. The log file will have the same name as the 
data file (“.QUE”) of the queue with a “.LOG” ending. 

Log files log the following events: 

•  Enabling/disabling logging 

•  The start of a print job 

•  The successful end of a print job 

•  Print job failures 

You can delete a log file by pressing the Delete log file button in the Queue configuration dialog. 

 

Changing the Queue Port 
You can view/change the port that WinRascol uses to send images to the film recorder. Select Queue 
Port from the File menu. A dialog will pop up showing the currently selected port. Select Change to 
enter the dialog in “Adding a queue” on page 38. Detect the new port and press Ok to exit. 
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Communication Test 
The diagnostics dialog is used to verify communication with a film recorder. Select Diagnostics-
>Communication Test from the File menu to open this dialog: 

 
Turn on the film recorder and select Run test to start the communications test. The field Test status 
will inform you of progress made. 

� NOTE: The film recorder needs to be turned on to run this test. However, it does not need to be 
warmed up. The film recorder can perform the communication test about five seconds after 
being turned on. 

•  Firmware version: This field shows the version of the film recorder or RISCRascol firmware. 

•  Rascol memory: This field shows the amount of memory installed in your film recorder or 
RISCRascol. 

•  RIP Version: This field shows the version of RIP software loaded on the film recorder or 
RISCRascol (if any).  
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Alignment Pattern 
The alignment pattern is used to align third party bulk loader cameras. It is not needed for 
Lasergraphics camera backs. Lasergraphics camera backs are correctly adjusted at the factory. They 
are not designed to be adjusted in the field. 

Select Diagnostics->Alignment Pattern from the File menu to open this dialog: 

 

 
 

Select the brightness and the desired duration. Press Start.  

The alignment pattern will be displayed on the film recorder screen for the selected duration. The 
alignment pattern consists of a horizontal line with a center notch. The line alternates between the top, 
center and bottom of the screen. 

� NOTE: EDR systems will move the EDR drum as far out of the way as possible, but the pattern 
will still be partly obscured. 

� NOTE: The alignment pattern display can not be interrupted. 
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Scanner Helper Dialog 
The scanner helper dialog is used to calculate the optimal DPI setting of a scanner for given film 
recorder settings and a specific source image size to achieve maximum image quality while conserving 
time and disk space. The scanner helper dialog will also help you to crop your scan optimally. 

This scanner helper dialog is available as Scanner helper in the Help menu. 

 

This is the dialog: 

 

 
Fill in the fields under Settings as follows: 

•  Enter the picture width and height (you can choose between inches and centimeters. Decimal 
places are allowed. 

•  Choose the resolution of the film recorder. 

•  Choose the film type. 

•  Select the desired cropping method. 

As you type, the dialog will update the fields on the right side: 
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•  Scan width and Scan height are the optimally cropped scan width and height. 

•  The Optimal scanner DPI is the optimal scanning density for maximum image quality and 
minimal scan file size. If your scanner does not support this setting, choose the next higher 
available setting. Most scanners support DPI settings in multiples of 300. 

•  Orientation will tell you whether to select Landscape or Portrait when imaging the scan with the 
film recorder. 

•  Scan size denotes the scan file size in megabytes. 

 

The diagram under Scan shows the original picture in black and the scanned part in gray. 

The diagram under Slide shows the entire printed slide (dashed) and the scanned image (gray). 

 

Press Exit to leave this dialog. 
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Chapter 8: Networking WinRascol 
 

 

 

Networking WinRascol is an advanced topic. This chapter was written for the benefit of network 
supervisors. Please seek help from seasoned computer professionals if you run into trouble when 
networking WinRascol. 

 

Principle of Operation 
Networking WinRascol is accomplished with drop box directories. One or more “clients”  generate 
images in the form of BLL files and drop them into drop box directories. A “server” periodically scans the 
drop box directories and images all files dropped into it. The drop box directory can be local to the 
“server” but can also reside on the network. 

Note that all film recorder settings chosen in the BLL-generator (printer driver) on the “client” machine 
are part of the BLL. The “server” extracts these settings, so no film recorder options need to be set on 
the “server”. Of course, settings like the film type must be appropriate for the target film recorder. 
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Creating a WinRascol Network 
Install WinRascol on the “server” first. The “server” can be a machine running Windows NT/2000/XP or 
Windows 9x/ME. 

•  Install the film recorder: See ”Chapter 3: Hardware Installation” on page 25 for details. 

•  Install WinRascol 5: See “Running setup” on page 36 for details. 

•  Install a queue: See “Adding a queue” on page 38 for details. 

•  Chose a drop box directory and point WinRascol to it: See “Changing the Drop Box Path” on 
page 99 for details. Don’t forget to make sure that a BLL subdirectory in the drop box directory 
exists or the WinRascol “server” will not be able to print from applications. Note that the drop 
box directory can reside on a network directory. 

•   Make sure the “server” has full access to the drop box directory. It will need read, write, 
rename, delete and directory access. 

Now install Windows BLL Generator on any number of “Client” machines (PC’s). 

•  Make sure the “client” has full access to the drop box directory. “Clients” will need read, write, 
rename and directory access. 

•  Install Windows BLL Generator 4: See “Managing BLL-Generators” on page 97 for details. 

Remember to set the drop box path of the BLL-generator to the drop box path of the “server” 
queue. 
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Keeping print jobs separate 
In order to keep sequences of print jobs of several people printing at the same time separate, you will 
need to create separate queues for each user. WinRascol 5 allows you to create multiple queues for a 
single film recorder for this purpose. Each user will be assigned a separate drop box directory. This 
allows WinRascol to keep print jobs in order. Note that this constitutes a significant change over 
previous versions of WinRascol where a single queue could have multiple drop boxes. 

If you expect that it may take longer for images to be dropped off than it will take to image them while 
other users add files to other queues at the same time you should make use of the queue blocking 
option. See “Changing ” on page 93 for details. 
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Macintosh as Client 
You can similarly use an Apple Macintosh as a client computer by configuring its BLL-generator to drop 
its BLLs on the Windows “Server”. The Macintosh BLL Generator can be downloaded from 
Lasergraphics’ web page http://www.lasergraphics.com. Please refer to the MacRascol documentation 
for details. 

The Macintosh will need to have read, write, rename and directory access to the drop box directory on 
the PC. Please refer to the applicable Windows and Apple Macintosh documentation for details on how 
to access a PC from a Macintosh. 

� NOTE: If you want to image BLLs created with Mac BLL Generator 5 or above with WinRascol 
you will need WinRascol 5.1 or higher and a MacRascol 5 (or higher) license. Enter the serial 
key of MacRascol in File->Edit serial keys in WinRascol to enable Mac BLL imaging. 

http://www.lasergraphics.com/
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Chapter 9: Uninstaller 
 

 

 

When to use the Uninstaller 
The uninstaller is used to remove all components of WinRascol from your computer. You will want to do 
this when 

•  You do not intend to use WinRascol on your computer any longer. 

•  The WinRascol installation has been corrupted. While you can reinstall WinRascol over a 
corrupted installation of WinRascol 5, this is not recommended. 

You do not need to uninstall WinRascol when 

•  You want to install an update of WinRascol 5. 

•  You have used a BLL Generator configured in WinRascol 5 and now want to attach a film 
recorder directly. Select File->New Queue in this case. Refer to “Adding a queue” on page 38 
for details. 

•  You have used a film recorder directly using WinRascol 5 but want to configure a BLL-
generator. Select File->BLL-generator Configuration in this case. Refer to “Managing BLL-
Generators” on page 97 for details. 
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How to use the Uninstaller 
You can uninstall the WinRascol package by selecting Uninstall in the WinRascol program group. 
Uninstall will do the following: 

•  Remove all WinRascol printer drivers 

•  Remove all WinRascol system drivers (NT only) 

•  Remove all WinRascol program and data files 

•  Remove all WinRascol related entries in the WIN.INI 

•  Remove all WinRascol entries in program groups (Startup and WinRascol) 

� NOTE: It is best to run Uninstall after rebooting the computer and exiting all programs. Some 
programs tend to leave printer drivers activated. Uninstall will fail in this case. 
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Chapter 10: Tips and Tricks 
 
 

 

This section gives tips and tricks on particular image types and applications. 

Specific Image Types 

Black and White Bitmap Images 
This section describes how to work with images made up of black and white bitmaps.  Many paint 
programs, such as Publisher's Paintbrush, can create black and white bitmaps. 

� NOTE:  To print Photoshop 2.5, TARGA or TIFF files, you do not need to use the Print 
command from your application.  You can simply add the raster files to a WinRascol RIP 
queue.  And you can skip this section. 

These are the recommended WinRascol Driver settings for black and white bitmap images: 

 

Fine Resolution: There is no benefit to using higher resolution on a black and white bitmap unless its 
resolution is greater than 4096 pixels across. 
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Color Bitmap Images 
This section describes how to work with images made up of color bitmaps.  Most paint programs, such 
as Photoshop and PhotoStyler, can create color bitmaps. 

� NOTE:  To print Photoshop 2.5, TARGA or TIFF files, you do not need to use the Print 
command from your application.  You can simply add the raster files to a WinRascol RIP 
queue.  You will need to enter the settings in the queue however. 

These are the recommended WinRascol Driver settings for color bitmaps: 

Fast Resolution: Only use Extra Fine resolution if you have a high-resolution bitmap greater than 
4096 pixels across. Use Ultra Fine resolution if you have a high resolution bitmap greater than 8192 
pixels across. 
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Printing Images Created for Other Printers 
This section describes how to print images that are created for other printers. 

 

1. Open the image file with your Windows application. 

2. Select WinRascol Driver as the output printer. 

Please refer to the “Printing from an Application” on page 46. 

3. Configure WinRascol Driver. 

Please refer to the “Printer settings in Windows 9x” on page 68 or “Printer settings in Windows NT” 
on page 75. 

4. Match your application's page setup with WinRascol. 

� WinRascol Driver lets you specify Orientation and Output Size.  If your application also 
provides these settings under its Page Setup, Slide Setup or Printer Setup command, you 
should make sure the options specified in your application match those specified in WinRascol 
Driver. 

5. Change all the fonts in your images to TrueType, ATM or CS fonts. 

6. Check the layout of your images. 

� After changing the page setup and fonts, the layout of your images may be altered.  Therefore, 
you may have to fix the layout of your images. 

7. Print your images. 
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Specific Applications 

Adobe Type Manager (ATM) 
WinRascol is fully compatible with Adobe Type Manager (ATM) fonts, version 1.15 or newer.  These 
fonts produce smooth text at any size and match text layout in your output with your image on screen. 

In ATM Control Panel, make sure the Print ATM fonts as graphics option is checked; otherwise, very 
large ATM text may be missing in your output. 

Arts & Letters 
The long names of WinRascol devices may cause problems with Arts & Letters. To get around the 
problems, you can shorten the WinRascol device names: 

1. Open Start->Settings->Printers 

2. Select the WinRascol printer 

3. Use File->Rename to shorten the name of the printer 

Corel Draw 
In order to get a realistic preview of the document, be sure that the color selected as the Paper Color in 
CorelDRAW's Page Setup window matches with the Background Color in WinRascol Driver's setup 
window. For example, when printing to the film recorder, WinRascol's default background color is black.  
Set Paper Color in CorelDRAW's Page Setup window to black, so that the preview of the image in 
CorelDRAW will be correct. 

If you are using CorelDRAW 3.00 Rev B or later, adding the following entry to the [CDrawConfig] 
section of the CORELDRW.INI file will significantly improve the printing times of certain images:  
UseClippingForFills=0

In the Print window of CorelDRAW, make sure the Print to File box is not checked. 

Corel Draw 7 
When using gradient fills in Corel Draw 7, make sure to select the highest number of steps at every 
opportunity to avoid banding. Especially in the dialog hidden under Print����Options->Options. 

Also make sure to disable color management for composite print under Tools->Color Manager. This 
will prevent seeing the very strange discoloration caused by the default profile.  
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CorelDraw 8 
CorelDraw 8 will generate erroneous output when you choose a value higher than 256 for the number 
of fountain steps in the miscellaneous printer options. CorelDraw 8 will even crash while printing 
gradient fills if the number is very high, like 2000. 

Freelance Graphics for Windows Ver 1.0 
If the text and/or objects on your slides are printed with a different color than those on your screen, do 
the following:   

1. In the Page Setup window of Freelance, click on Color Map. 

2. Select Use Window's color map. 

All bitmaps will appear in black and white when printed with WinRascol.  This problem is fixed in 
Freelance Graphics for Windows ver 2.0. 

Freelance Graphics 97 
Freelance Graphics 97 has a bug that makes it preview and print in black and white to true color 
devices like Lasergraphics film recorders. Please enable the Lotus Freelance workaround outlined in 
“Changing global driver settings” on page 95 if you experience this problem. 
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Persuasion 
To make Persuasion print faster to WinRascol, you can modify the ALDUS.INI file.  (The ALDUS.INI file 
is usually located in the USENGLSH subdirectory under your ALDUS directory.)  Use a text editor (such 
as EDIT.COM from MS-DOS or NotePad from Windows) to add the following lines to the end of the 
ALDUS.INI file: 

[your_WinRascol_printer_name]

NoPatternOnlySolidFill=0

ROPtype=0

StretchImage=0 

where your_WinRascol_printer_name is the name of the WinRascol printer as shown in the Installed 
Printer List of the Control Panel.  For example, if you have an LFR, the lines you should add are: 

[LFR]

NoPatternOnlySolidFill=0

ROPtype=0

StretchImage=0

If you have a Personal LFR, the lines you should add are: 

 

[Personal LFR]

NoPatternOnlySolidFill=0

ROPtype=0

StretchImage=0

 

After you have changed the ALDUS.INI file, restart Windows. 

 

� CAUTION:  Please make sure the lines you are adding follow exactly the format described 
here.  A spelling mistake or an extra space may cause Persuasion to ignore these lines with no 
warning. 
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PhotoStyler 
You must check the Halftone by Printer box in PhotoStyler's Page Setup window.  Otherwise, 
PhotoStyler will limit the bitmaps to 16 colors when printing to WinRascol Driver. 

If you choose Scale to Fit in the PhotoStyler's Print window, PhotoStyler will resample bitmaps to the 
film recorder's resolution instead of letting WinRascol do the work.  This will make WinRascol print job 
files very large and make the processing very slow. 

Word, Write 
These applications assume a white background and always print text in black.  So, when printing to the 
film recorder, you must explicitly select a white Background in WinRascol Driver's setup window.  
Otherwise, you will get black text printed on a black background.





 

 Specifications 119 

Appendix A: Specifications 
 

 

Specifications are subject to change without notice. 

 

 

Supported PCs Any IBM PC compatible with a Pentium processor or better and at 
least 16 MB of memory. Note that this represents the absolute 
minimum. You will need more memory if you intend to use Windows 
ME/NT/2000/XP and/or print from applications. 

 

Supported Output Devices All film recorders in the Lasergraphics LFR family are supported: 

•  Personal LFR 

•  Personal LFR PLUS 

•  LFR-X 

•  LFR Mark II 

•  LFR Mark II - Digital Photography Model (DPM) 

•  LFR Mark III 

•  LFR Mark III - Digital Photography Model (DPM) 

•  LFR Mark V - Digital Photography Model (DPM) 

•  LFR Mark VI - Digital Photography Model (DPM) 
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Supported Interfaces Standard interfaces: 

•  Parallel Port 

•  Rascol Port 

•  SCSI 

The following Rascol models are supported: 

•  Rascol II (Windows 9x only) 

•  Rascol IV (Windows 9x only) 

•  RISCRascol 

•  Internal Rascol 

Note: Not all film recorders support all types of interfaces. 

 

Supported Operating 
Environments 

Windows 95, Windows 98, Windows NT 4.0, and Windows 2000 

 

Input File Formats BLL (Binary Lasergraphics Language) 

HPGL 

LL (Lasergraphics Language) 

Photoshop 2.5 

TARGA 

TIFF 

DICOMED 

JPEG 

PCX 

BMP 

SGI 

PNG 
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Image Enhancements Color balance 

Gamma contrast 

Antialiasing 

 

Fonts TrueType 

ATM (Adobe Type Manager) ver 1.5 or later 

 

Software Selectable 
Resolution (Film Recorder) 

4000 lines (4096 x 2730 pixels) 

2000 lines (2048 x 1366 pixels) 

 

On LFR Mark III, LFR Mark III - Digital Photography Model, LFR 
Mark V – Digital Photography model 8000 lines (8192 x 5461 
pixels) are available. On the LFR Mark VI – Digital Photography 
Model 16000 lines are available 

 

Film Types  Lasergraphics Film Calibration (LFC) files, currently 228 additional 
film type and film recorder combinations  
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Appendix B: Troubleshooting 
 

This appendix describes some common problems and possible solutions. 

 

If you can't find a solution is this appendix, contact the Lasergraphics Technical Support Department: 

 

Technical Support Department (949) 753-8292 

Monday through Friday 

7:30 A.M. to 5:30 P.M., Pacific Time Zone 

 

Our web site: http://www.lasergraphics.com 
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When a problem occurs, try this simple reset procedure: 

 

1. Quit WinRascol. 

2. Exit Windows and then turn off your PC. 

3. Turn off the RISCRascol and then the LFR. 

4. Wait 30 seconds. 

5. Turn on the film recorder and then the RISCRascol (if attached). 

6. Turn on your PC and retry the operation that caused problems. 

 

If the problem persists, refer to the following sections.  Look for your problem and follow the suggested 
solutions.  Also, check the user guide that came with your film recorder for further troubleshooting 
procedures. 

The next three sections will discuss the following categories of problems: 

•  Communication Problems 

•  Error Messages 

•  Output Problems 
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Communication Problems 
This section describes problems related to film recorder communication. 

I’m having problems using my film recorder with an Adaptec 2940 
type controller on Windows NT 4.0 
The Adaptec driver that comes with Windows NT 4.0 Service Pack 3 has been reported to cause 
system hangs when used with Lasergraphics film recorders. Please ask your dealer for instructions on 
how to update the Adaptec driver. 

I’m having problems attaching my film recorder via SCSI 
Attaching external devices to SCSI can be an involved project. The following steps will cure many SCSI 
related problems: 

•  Power down the film recorder and the computer. 

•  Make sure the cables between your computer and the film recorder are firmly connected. 

•  Make sure there are no conflicting SCSI IDs on the bus. 

•  Make sure that there are no T-type joints on the SCSI bus. The SCSI bus must be a single line. 

•  Verify that the SCSI bus is terminated properly at both ends and that there are no more than 
two terminators and terminated devices connected to the SCSI bus. 

•  Make sure to turn off SCAM support if your SCSI adapter has this option. 

•  Make sure you use 16 bit termination on both ends of the SCSI-bus if you are using Wide-SCSI. 
The film recorder is an 8-bit SCSI device so you cannot use a terminator attached to the film 
recorder to terminate a Wide-SCSI-bus. 

•  Make sure your SCSI system does not violate any SCSI-restrictions regarding cable length and 
cable quality. Ultra-SCSI buses can be limited to 1.5 meters in length total. This includes 
internal and external SCSI cable. 

•  Power up the film recorder first, then the computer. Try connecting to the film recorder now. 

With the complexity of the SCSI standard as it is today, it is strongly recommended to let a trained 
professional perform such installations. 

Note that Windows 95/98 requires the film recorder to be turned on and connected before starting 
Windows 95/98. 
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Communication Tests from WinRascol fail 
Symptom: The film recorder is detected by WinRascol, but the communication test (Diagnostics) 
doesn’t work.  

Solution: Check cabling, disable special parallel port modes (parallel port system), remove other SCSI 
devices (SCSI system), tell the SCSI adapter to use asynchronous mode at 5Mhz (SCSI system). 

WinRascol cannot detect or communicate with Rascol II or 
RascolPort on Windows 95/98/ME 
Check for hardware conflicts as follows: 

•  Right-click the My Computer icon 

•  Select Properties 

•  Select the Device Manager tab 

•  Under the heading Ports, find Printer Port.  Errors are indicated by yellow circles around an 
exclamation mark "!".  If any errors exist, click Properties then General, and read the error 
message. 

•  If you discover a conflict, right-click the My Computer icon, select Properties,  Select the Device 
Manager tab, select the Computer icon, and click Properties to see a list of which device is 
using each resource setting on your computer. 

� NOTE: This procedure will not detect all types of hardware conflict. Generally, if you set a 
RascolPort to LGP4 or LGP5 you avoid almost all common problems. The same goes for the 
Rascol II board when it is set to P3 (278H). 
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WinRascol RIP cannot detect or communicate with Rascol II 
The JP2 jumpers on the Rascol II board select a serial or parallel port address for the Rascol II to use 
for communication.  If this address is used by another device, WinRascol will not be able to 
communicate with the Rascol II.  In this case, you should do the following: 

1. Exit Windows and then turn off your PC. 

2. Discharge any static electricity from your body or clothing by touching a grounded metal object. 

3. Take your Rascol II board out of your PC. 

4. Reinstall the Rascol II and make sure the JP2 jumpers on the Rascol II board are set correctly.  For 
more information, please refer to “Installing the Rascol II board” on page 29. 

5. If WinRascol Setup can find your Rascol II now, note the port that the Rascol II is connected to. 
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WinRascol cannot detect or communicate with Rascol IV 
You can use the PS/2 System Reference Disk to select a serial or parallel port address for the Rascol 
IV board to use for communication.  Make sure this address is not used by another device.  Reinstall 
the Rascol IV.  For more information, please refer to the “Installing Rascol IV” on page 30. 

WinRascol cannot detect or communicate with RISCRascol or Film 
Recorder using the parallel port 
Make sure your film recorder or RISCRascol is properly connected to a parallel (LPT) port or the 
RascolPort. Select “standard parallel” as the port type. 

Error Messages 
This section describes the common WinRascol error messages. 

WinRascol cannot rasterize on PC 
Your device does not support PC rasterization.  Rasterization must be performed on the device.  This 
occurs with Rascol II and Rascol IV boards that require an upgrade.  You will need to have your dealer 
upgrade the Rascol II or Rascol IV board. 

PC:  (Error #D1)  Not enough memory for rasterizer to work. 
•  Increase the rasterizer memory setting. See “Changing global driver settings” on page 95 for 

details. 

•  Exit some applications, or 

•  Try printing the image again using Fast Resolution and No antialiasing, or  

•  Add more memory to your PC. 

(Error #D3)  Camera is out of film. 
The camera back ran out of film while exposing the images in the queue.  Unload the film and add a 
new roll.  Follow the instructions provided in your film recorder manual for loading and unloading film. 
WinRascol will attempt to restart imaging every two minutes. 

(Error #D4)  Missing or Wrong camera back. 



 

 Output Problems 129 

This error occurs when the camera back is not connected to the film recorder or the camera type does 
not match the film type specified in the print job. 

(Error #D6) Device communication error 
This error can have multiple reasons. Most common are a turned off film recorder and disconnected 
cables. In SCSI-systems, termination problems and cable quality are the main culprits. 

� NOTE: Auto-terminating SCSI-adapters like the Adaptec 2940 may require the film recorder to 
be turned on prior to turning on the computer.  

� NOTE: Windows 95/98 requires the film recorder to be turned on prior to booting Windows 
95/98. 

 (Error #D75)  Cannot rasterize this image: too complex. 
Try printing the image again using Fast Resolution and No antialiasing. 

Rascol:  (Error #D152)  The film type cannot be used with this film 
recorder. 
Error #D152 indicates that you have selected the wrong film recorder model in WinRascol Setup.  You 
can run WinRascol Setup again to reinstall WinRascol. 

Output Problems 
This section describes problems that may occur when processing print jobs. 

A print job is still not finished after a long time 
There are several possible causes: 

 

•  You are using an Adaptec 2940 series controller on Windows NT 4 Service Pack 3 and the 
communication with the film recorder hangs. Ask your dealer for instructions on how to update 
the Adaptec driver. 

•  Your print job is very complicated.  For example, your image uses a lot of smooth shading, large 
bitmaps or antialiasing.  Cancel your print job and try to print your image again with no 
antialiasing. 

•  To avoid slice marks, Rascol implements automatic exposure time control by timing how fast 
your PC is sending data to the Rascol at the beginning of each print job.  If your PC is busy with 
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other applications while Rascol is timing your PC, Rascol will force a slow exposure.  This 
makes the current print job slow but avoids slice marks.  To avoid both slow exposure and slice 
marks, try not to keep your PC busy when WinRascol is printing a large print job. 

•  Other Windows applications are keeping your PC very busy.  For example, many Windows 
applications do not let other applications run during the printing process.  In this case, 
WinRascol print jobs will be very slow until your application finishes its operations. 

•  You are printing a portrait mode image and the status field of WinRascol says “Preprocessing 
Image.”  Stop WinRascol, free up as much memory as possible on your PC and then resume 
WinRascol. 

•  There may be a communication problem between WinRascol and your film recorder.  Cancel 
your print job and run the Diagnostics Tests from WinRascol.  For more information, please 
refer to the “Communication Test” on page 101. 

•  Adding more memory to your film recorder or RISCRascol can sometimes dramatically improve 
the processing speed. This is especially true when the I/O board is equipped with the minimal 
amount (less than 1 Megabyte). The memory available for processing and buffering images on 
your film recorder can be determined using Diagnostics, selected from WinRascol's File menu.  
See “Communication Test” on page 101.Please contact your dealer regarding information on 
memory upgrades. 

•  Antialiasing is turned on. Antialiasing consumes a lot of processing power. Turn off antialiasing 
for higher speed. 



 

 Output Problems 131 

Text alignment does not match the original 
There are several possible causes: 

 

•  The page size selected by your application does not match the Output Size setting of 
WinRascol Driver. 

•  You are not using TrueType or ATM fonts. 

Text and other objects are missing in output 
Some applications, especially word processing applications, do not specify a background color when 
they print.  In these cases, the Background Color specified in the WinRascol Driver setup window is 
used.  If this background color is the same as the color of the missing text or objects, you can simply 
match the Background Color in the WinRascol Driver setup window with what your application shows 
on screen and reprint your images. 

Font does not match the original 
Make sure you are using TrueType and ATM fonts. 

Background color does not match the original 
Some applications, especially word processing applications, do not specify a background color when 
they print.  In these cases, the Background Color specified in the WinRascol Driver setup window is 
used.  So, you can simply match the Background Color in the WinRascol Driver setup window with what 
your application shows on screen and reprint your images. 

Few periodic faint horizontal lines 
For complex images the computer may not be able to send data to the film recorder fast enough.  If you 
notice any periodic faint horizontal lines in the output that are not in the original image, try adjusting the 
exposure time using the Exposure Time setting in the Advanced Film Recorder Options window of 
WinRascol Driver and in the WinRascol Print Manager Setup window.  Try setting the exposure time to 
1.5 times the normal imaging time of the problem image.  If this does not work, experiment with longer 
times. 



 

132 Troubleshooting 

Miscellaneous Problems 
This section describes problems that do not belong to the previous sections. 

Image in Dropbox Directory is not added to the queue 
The causes for this problem are: 

•  There is not enough space on the disk that your queue resides on.  Try freeing up some disk 
space. 

•  All files with filename extensions that end with the ~ character are assumed by WinRascol Print 
Manager to be in the queue already.  If the image is not added to the queue yet but has a 
filename extension that end with the ~ character, try changing the filename extension. 
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antialiasing   Assigning pixels at the edges of objects a graduated gray scale of values.  This 
dramatically reduces the appearance of jaggies. 

Binary Lasergraphics Language (BLL)   A proprietary WinRascol print job format. 

bitmap   A type of graphic composed of a rectangular group of colored dots.  Bitmaps have jagged 
edges when output at high-resolution. 

BLL   An abbreviation for Binary Lasergraphics Language. 

camera back   A film recorder's camera. 

client computer   A computer without a film recorder.  Users on client computers can put image files in 
dropboxes so that the WinRascol server PC can pick up the image files and print them. 

contrast   Measures the range of shades between light and dark.  Black and white is high contrast, 
whereas two similar shades of gray is low contrast. 

crop   To trim an image prior to output. 

DPI   Dots per inch.  Commonly used to specify printer resolution. 

DPM   Digital Photography Model.  A film recorder model that is customized for digital photography. 

Dropbox   A shared directory where network users can put image files.  A dropbox directory is scanned 
by WinRascol periodically for image files to process.  Dropboxes make film recorder sharing very easy. 

font   A typeface. 

HPGL   A popular computer-aided design drawing format on PCs. 

jaggies   Within an image, steps along the edge of a shape that should be smooth.  Jaggies are 
reduced by increasing resolution and/or antialiasing. 

landscape   An output orientation where the width is greater than the height.  Also known as horizontal 
or wide format.  Compare to portrait. 
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Lasergraphics Language   A powerful graphics language that is common in the mainframe and 
minicomputer environments. 

Lasergraphics Film Calibration file   A file that provides calibration data of a film type for a specific 
LFR model.  Therefore, the LFC file of 35mm Vericolor for LFR Mark III is different from the one for LFR 
Mark III - Digital Photography Model. 

LFC file   See Lasergraphics Film Calibration file. 

LFR   Lasergraphics Film Recorder.  Refers to a family of film recorders including the LFR, LFR PLUS, 
Personal LFR, Personal LFR PLUS, LFR-X, LFR Mark II, LFR Mark III, and the Digital Photography 
Models Mark II DPM, Mark III DPM, Mark V DPM and Mark VI DPM. 

LL   An abbreviation for Lasergraphics Language. 

object   A type of graphic composed of graphic primitives (e.g. circles, lines, polygons, etc.).  The 
graphic primitives are represented by their mathematical coordinates.  Objects reproduce well at high 
resolution. 

output   To create an image on a film recorder. 

pixel   An acronym for picture element.  A pixel is a single dot on your monitor or output device. 

portrait   An output orientation where the height is greater than the width.  Also known as vertical or tall 
format.  Compare to landscape. 

printer driver   Software that knows how to communicate with a printer device. 

queue   A directory on your hard disk for storing temporary WinRascol RIP print job files. 

Rascol   Refers to a family of high speed Lasergraphics image processors.  Instead of burdening the 
PC, WinRascol lets the Rascol perform the time- and memory-consuming task of rasterization.  This 
way you can continue to do work on your PC while the Rascol is busy rasterizing.  The Rascols also 
control the Lasergraphics film recorders. These days PCs have become so fast that they usually 
rasterizer faster than Rascol devices. 

Rascol II   A Rascol model that plugs into your PC and acts as a fully independent co-processor that 
performs rasterization and controls the film recorder. 

Rascol IV   A Rascol model that plugs into your PS/2 and acts as a fully independent co-processor that 
performs rasterization and controls the film recorder. 

RascolPort   A high performance communication port for connecting to RISCRascol and Internal 
Rascol.  It can emulate the standard bi-directional parallel (LPT) port to work with most third party 
printers. 

raster   See bitmap. 

rasterization   A time- and memory- consuming process for converting graphics objects into rasters for 
output. 

resolution   The total number of dots in an image.  Film recorder resolutions measured in lines 
represents the number of dots across the image. 
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RISCRascol   A Rascol model that offers dramatic speed increase for the Lasergraphics film recorders.  
For complex images, the RISCRascol is 15 times faster than the Rascol II/IV. 

server PC   A PC connected to a film recorder .  The PC can run WinRascol Network Version to share 
the film recorder with other network users via dropboxes. 

TARGA   A popular bitmap file format for PCs. 

TIFF   A popular bitmap file format for PCs. 
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24-bit color, 18 

35mm prints, 17 

35mm slides, 17 

Adobe Type Manager, 60, 
113, 114, 131 

alignment pattern, 102 

Antialias, 90 

Antialiasing, 65 

Application 

Printing from, 46 

applications 

draw, 60 

illustration, 60 

paint, 60 

Arts & Letters, 61, 114 

Aspect Ratio, 89 

ATM, 60, 113, 114, 131 

auto deletion, 52 

Background Color, 65, 76, 
90 

Best Fit, 89 

Binary Lasergraphics 
Language, 19 

Bitmap, 60 

Color, 112 

Monochrome, 111 

BLL, 19 

BLL-generator 

Add, 97 

Change path, 98 

Delete, 98 

Manage, 97 

Using, 98 

bus 

EISA, 26, 29 

ISA, 26, 29 

bus speed, 26, 29 

Canvas, 61 

Charisma, 61 

Client Computers 

printing on, 51 

Color 

Background, 65, 76, 90 

fidelity, 59 

Pen, 66, 91 

true-color, 18 

Color Balance, 66, 71, 77, 
88 

Column 

Display, 83 

Hide, 83 

communications test, 101 

Configuration 
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General, 93 

Contrast 

Gamma, 66, 71 

Copy count, 87 

CorelDRAW, 61, 114 

Cropping, 89 

Designer, 61 

Diagnostics, 101 

DICOM, 19 

Drag and Drop, 81 

dropbox, 51, 54, 56, 93, 132 

EISA, 26, 29 

Emulation, 91 

Error messages, 128 

Excel, 61 

Exposure Speed, 77, 90 

Exposure Time, 65, 72 

Fill Frame, 89 

Film recorder 

Installation, 31 

film transparencies, 17 

Film Type, 65, 70, 86 

Film Types, 121 

font 

ATM, 60, 113, 114, 131 

Freelance, 61, 115 

Freelance Graphics for 
Windows, 115 

Gamma, 77, 88 

Contrast, 71 

Guided tour, 41 

Hardware 

Installation, 25 

Required, 14 

Harvard Graphics, 61 

HPGL, 19, 91 

IBM PC, 19 

image type, 19 

BLL, 19 

HPGL, 19 

LL, 19 

Photoshop 2.5, 19 

TIFF, 19 

ISA, 26, 29 

jumpers, 27, 28, 127 

Lasergraphics Language, 19 

LFR, 17 

Line Thickness, 67, 91 

LL, 19 

Log 

queue, 100 

Macintosh 

as client, 108 

MacRascol, 19, 108 

mainframes, 19 

Microsoft Word, 117 

minicomputers, 19 

Networking, 105 

objects, 60 

Orientation, 64, 70, 76 

Output Size, 64, 70 

PageMaker, 61 

Paper Size, 64, 70, 76 

Parallel port, 21, 31, 126 

Pen Colors, 66, 91 

Persuasion, 61, 116 

Photoshop, 19, 61 

PhotoStyler, 61, 117 

Plotter emulation, 66, 91 

Polaroid prints, 17 

port 

parallel, 31 

RascolPort, 26, 31 

PowerPoint, 61 

Preferences, 93 

Preview 

Print Job, 84 

Print Job 

Changing status, 82 

Delete, 84 

Manage, 82 

Move, 84 

Preview, 84 

Select, 83 

Settings, 85 

Status, 82 

Printer Driver, 51 

Manage, 96 

Windows 95/98, 68 

Windows NT, 75 
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Printing 

From application, 46 

Queue, 53 

Add, 99 

Add print job, 79 

Adding, 38 

Delete, 99 

Diagnostics, 101 

Drag and Drop, 81 

Dropbox path, 99 

Log, 100 

Port, 100 

Settings, 99 

Start, 82 

Stop, 82 

Rascol II, 21, 29, 32 

bus speed, 29 

Installation, 29 

jumpers, 21, 29, 127 

Rascol IV, 32, 128 

Installation, 30 

RascolPort, 21, 26, 31, 32 

bus speed, 26 

installation, 21, 26, 27 

jumpers, 27, 28 

parallel port emulation, 
26 

with dongles, 26 

with parallel network 
interfaces, 26 

with parallel tape drives, 
26 

with third party printer, 
26, 28 

Reference, 63 

Resolution, 63, 69, 76 

defined, 58 

image resolution, 17 

RISCRascol, 32 

Installation, 31 

port, 31 

Scaling, 65, 72, 90 

scanner, 103 

SCSI, 21, 31, 126 

SCSI ID, 33 

Server PC 

printing on, 51 

Settings, 63 

Default, 74, 78, 92 

Windows 95/98, 68 

Windows NT, 75 

Setup, 36 

slice marks, 65 

slide 

2000-line, 59 

4000-line, 59 

8000-line, 59 

Specifications, 119 

Technical Support, 123 

test slide, 42 

text 

bitmap, 60 

object, 60 

TIFF, 19 

Troubleshooting, 123 

Uninstalling WinRascol, 109 

Web site, 123 

What’s new, 16 

Windows 3.1x, 16 

WinRascol 

About, 17 

Installation, 35 

Networking, 105 

Version 3.15, 16 

What’s new, 16 

WinRascol32, 51 

Exit, 79 

Installation, 36 

Running for the first 
time, 37 

Start, 79 

Word, 117 
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